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1 Foreword
The DriveControlSuite commissioning software for 6th generation drive controllers offers convenient functions for efficient
project configuration and commissioning of drive controllers in multi-axis and single-axis applications.

The Drive Based Synchronous application contained in the software provides universal solutions for drive-based motion
control using position, velocity and torque/force control types. The motion commands associated with these control types
are categorized into the following operating modes:

§ Command

§ Motion block

The Drive Based Synchronous application enables you to operate axes in synchronous operation, e.g. to use a virtual master
in order to move several axes on a platform equally or to use a master encoder in order to synchronize axes with an
upstream machine, such as when using conveyor belts.

Additional functions for monitoring process variables such as positions or velocities offer added convenience in monitoring.

This documentation describes the general functions of the Drive Based Synchronous application and guides you step by
step through the setup and project configuration of your drive project in the individual operating modes.
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2 User information
This documentation supports you in the setup and project configuration of your drive system with the Drive Based
Synchronous application in conjunction with Drive Based device control.

Technical knowledge

To be able to commission one or more drive controllers using the Drive Based Synchronous application, possibly in
combination with a controller, you should have basic knowledge of handling 6th generation STOBER drive controllers and of
the DriveControlSuite commissioning software.

Technical requirements

Before you begin operating your drive system, you need to have wired the drive controllers involved and initially check that
they are functioning correctly. To do this, follow the instructions in the manual for the relevant drive controller.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is mandatory for SC6 and SI6 series drive controllers in conjunction with the DriveControlSuite software
(DS6) in V 6.7-A or later and associated firmware in V 6.7-A or later.

2.3 Directives and standards
Refer to the drive controller documentation for the European directives and standards relevant to the drive controller and
accessories.

2.4 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.5 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

2.6 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

http://www.stoeber.de/en/downloads/
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2.7 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.7.1 Display of warning messages and information
Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.7.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

2.7.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

– Subtraction

+ Addition

× Multiplication

÷ Division

| | Absolute value

http://www.stoeber.de
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2.8 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

CANopen®, 
CiA®

CANopen® and CiA® are registered trademarks of CAN in AUTOMATION e.V.,
Germany, the international user and manufacturer association.

EnDat® EnDat® and the EnDat® logo are registered trademarks of Dr. Johannes Heidenhain
GmbH, Germany.

EtherCAT®,
Safety over EtherCAT®

EtherCAT® and TwinCAT® are registered trademarks and patented technologies,
licensed by Beckhoff Automation GmbH, Germany.

PLCopen® PLCopen® is a registered trademark of the PLCopen Organisation, Netherlands.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS
Nutzerorganisation e.V., Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.
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3 Safety notes

WARNING!

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller documentation may result in accidents causing
serious injury or death.

▪ Observe the safety notes in the drive controller documentation.

▪ Consider the residual risks in the risk assessment for the machine or system.

WARNING!

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on machines or systems which can lead to
serious injuries or death.

▪ Observe the security notes in the drive controller documentation.

▪ Protect the parameterization, e.g. from unauthorized access.

▪ Take appropriate measures for possible malfunctions (e.g. emergency off or emergency stop).
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4 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

4.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.
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Fig. 1: DS6: Program interface

No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.
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4.1.1 Configuring the view
In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

Icon Item Description

– Reset Resets the view to factory settings.

Project Shows/hides the Project window (project tree, project
menu).

Messages Shows/hides the Messages window.

Parameter check Shows/hides the Parameter check window.

Variable parameter lists Shows/hides the Variable parameter lists window.

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.
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4.1.2 Navigation using sensitive circuit diagrams

Fig. 2: DriveControlSuite: Navigation using text links and symbols

In order to graphically illustrate the processing sequence of actual and set values, the use of signals or the arrangement of
drive components and to make configuring the accompanying parameters easier, they are displayed on the respective
wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with a click.
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4.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

4.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.

Group Topic

 A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gearbox and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 1: Parameter groups
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4.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2 147 483 648 
– 2 147 483 647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or parameter
address

4 bytes (1 double word,
unsigned)

0 – 4 294 967 295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 
– 3.40282 × 1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 2: Parameters: Data types, parameter types, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

§ Text
Outputs or messages
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4.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 3: Parameter types

4.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

§ Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters 
(value range: 1 – 4).

§ Group
The thematic group to which a parameter belongs (value range: A – Z).

§ Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

§ Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

§ Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 – 31).
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4.2.5 Parameter visibility
The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the properties you project
for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or hidden
depending on other parameters or settings. For example, the parameters of an additional function are only shown as soon
as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.

Information

If a parameter exists in the configuration due to the projected properties of the drive controller (e.g. hardware, firmware,
application), it is generally available for fieldbus communication. The visibility of a generally available parameter has no
effect on its availability for fieldbus communication (e.g. through access level or parameter selection).
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4.3 Signal sources
Drive controllers are controlled either by a fieldbus, by terminals or by mixed operation consisting of a fieldbus system and
terminals. You can use the corresponding selection parameters, referred to as signal sources, to configure in
DriveControlSuite whether the control signals and set values of the application are obtained over a fieldbus or using
terminals.

In case of activation by using terminals, the respective analog or digital inputs are specified directly as the source. In case of
activation by fieldbus, parameters are selected as sources for control signals and set values, which must be part of the
process data mapping between the controller and drive controller so that the controller can write to them via fieldbus.

4.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller

To save the configuration in non-volatile memory on a drive controller, you have the following options:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard:
Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values:
Set the parameter A00[0] to the value 1: Active

§ Saving the configuration using the S1 operating button:
Press and hold the operating button for 3 s

Saving to all drive controllers within a project

To save the configuration in non-volatile memory on several drive controllers, you have the following options:

§ Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

§ Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start with the last correct configuration that was saved and with fault 40: Invalid data the next time it is
switched on. In order to acknowledge the fault and successfully complete the saving process, the configuration must be
stored again in non-volatile memory and the action must be completed.
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5 Commissioning
The following chapters describe how to commission your drive system using DriveControlSuite.

For the components of your axis model, we assume one of the following two combinations as an example:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

Synchronous servo motors are saved along with all relevant data for the project configuration in the DriveControlSuite
motor database and in the electronic nameplate. When the motor is selected from the database, as well as when the
nameplate is read out, all data is transferred to the corresponding parameters. There is no need for complex
parameterization of the motor, encoder and brake.

LM Lean motor without encoder (with optional brake)

Lean motors are stored in the motor database of the DriveControlSuite, along with all the data relevant for project
configuration. Furthermore, the motor data and the release and engaging times of the brake are part of the firmware.
When the motor is selected from the database, all data is transmitted to the corresponding parameters. There is no need
for time-consuming parameterization of the motor and brake. For optimum operation of the Lean motor, it is only
necessary to parameterize the cable length and the mass inertia ratio of the load to the motor and, if necessary, activate
the brake.

For asynchronous motors, the motor data relevant for project configuration is also taken from the motor database. All
other motor types need to have their parameters configured manually.

Before you begin commissioning, make sure that the system nodes are hooked up and supplied with control voltage.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.



STOBER 5 | Commissioning
10

/2
02

5 
| 

ID
 4

43
05

9.
04

21

5.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

5.1.1 Projecting the drive controller and axis
Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:
Define the reference code (equipment code) of the drive controller.

1.2. Designation:
Give the drive controller a unique name.

1.3. Version:
Version your project configuration.

1.4. Description:
If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:
Select the series, device type and firmware version of the drive controller.

3. Option modules tab, Safety module:
If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Project the basic control of the drive controller.

4.1. Device control:
Select device control Drive Based.

4.2. Rx process data, Tx process data:
If you use a fieldbus to control the drive controller, select the corresponding receive and transmit process data.
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Projecting the axis

1. Click Axis A.

2. Properties tab: 
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the axis.

2.2. Designation:
Give the axis a unique name.

2.3. Version:
Version your project configuration.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Application tab:
Select the Drive Based Synchronous application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter
the accompanying motor data later.

5. Repeat the steps for axis B (only for double-axis controllers).

6. Confirm with OK.

5.1.2 Configuring safety technology
If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step (see Further information [} 148]).

5.1.3 Creating other drive controllers and modules
In DriveControlSuite, all drive controllers within a project are grouped using modules. If you add a new drive controller to
your project, be sure to always assign it to an existing module. Group drive controllers in a module if, for example, they are
located in the same control cabinet or work together to operate the same machine part.

Creating a drive controller

1. In the project tree, select your project P1 > module M1 > context menu Create new drive controller.

ð The drive controller is created in the project tree and the configuration dialog opens.

2. Project the drive controller as described in Projecting the drive controller and axis [} 21].

3. Repeat the steps for all other drive controllers that you want to project.

Creating a module

1. In the project tree, select your project P1 > context menu Create new module.

ð The module is created in the project tree.

2. Project the module as described in Projecting the module [} 23].

3. Repeat the steps for all other modules that you want to project.
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5.1.4 Projecting the module
Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the module opens.

2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the module.

2.2. Designation:
Give the module a unique name.

2.3. Version:
Version the module.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.

5.1.5 Projecting the project
Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the project opens.

2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the project.

2.2. Designation:
Give the project a unique name.

2.3. Version:
Version the project.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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5.2 Mapping the mechanical axis model
To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

5.2.1 Parameterizing the motor
You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. All additional data
on the brake and encoder is transferred at the same time.

Lean motor without encoder (with optional brake)

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. You only have to
parameterize the cable length in use and the mass inertia ratio of the load to the motor. Even the brake purging and
engaging times are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:
Select the cable length of the power cable in use.

4. Select the Control cascade wizard > Control mode.

5. C30 J-Last / J-Motor:
Parameterize the mass inertia ratio of the load to the motor.

6. Repeat the steps for the 2nd axis (only for double-axis controllers).

Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).
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5.2.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:

§ Define the axis model

§ Scale the axis

§ Parameterize the position and velocity window

§ Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must parameterize the axis model for each axis
individually.
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5.2.2.1 Define the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying positions, velocities, accelerations and jerk, select 0: User defined, rotational or 1: User defined,
translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying positions, velocities,
accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:
Select the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Select the interface to which the position encoder is connected.

6. I00 Position range:
Select whether the travel range of the axis is limited or endless (modulo).

Information

When you parameterize I05 Type of axis, you can either use selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (I09)
and the decimal places (I06) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s2, jerk in rad/s3.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s2, jerk in m/s3.

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder is used for position control as
standard.
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5.2.2.2 Scale the axis

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,
accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless = I00 Position range, define the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
unit of measure.

7. I03 Axis polarity:
Use the polarity to define the direction of interpretation between the axis movement and motor movement.

Information

A change to parameter I06 moves the decimal separator for all axis-specific position values! Ideally, define I06 before
parameterizing other position values and then check them.

If the axis receives set value specifications from a controller or follows the master values of a master, the resolution of
position values directly impacts the smooth operation of the axis. Therefore, you should define a sufficient number of
decimal places appropriate for your application.

Information

Parameter I297 Maximum speed position encoder must be parameterized according to your application case. If I297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places position, I09 Measure unit as well as
I07 Distance factor numerator position and I08 Distance factor denominator position or A585 Feed constant for CiA 402. If
you have made changes to one of the parameters listed, select I297 accordingly as well.
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5.2.2.3 Parameterizing the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:
Parameterize a tolerance window for velocity tests.

3. I22 Target window:
Parameterize a tolerance window for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.

5. I21 Maximal following error:
Parameterize a tolerance window for lag tests.

For more information on monitoring the lag, see Lag monitoring [} 144].

5.2.2.4 Limiting the axis

As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration, jerk and torque/
force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling provides you with the Conversion of
position, velocities, accelerations, torque/force scaling calculator, which calculates the effects of changed motion variables
on the entire system. You can use the scaling calculator to enter values for motion variables of the motor, gearbox output
and axis in order to convert the values to all other locations in the axis model.

Limiting the position

To secure the travel range of the axis, you have the option to limit the permitted positions using a software or hardware
limit switch.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. I101 Source positive /limit switch, I102 Source negative /limit switch:
To limit the travel range of the axis in the positive or negative direction of motion via hardware limit switches, select
the source of the digital signal that is used to evaluate a limit switch at the positive or negative end of the travel range.

3.1. If bit 1 or bit 2 of the control word I210 of the application is the source, select 2: Parameter.

3.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

4. I50 Software stop positive, I51 Software stop negative:
If you selected 0: Limited for I00 and would like to limit the travel range of the axis via software limit switches, define
the largest or smallest permitted position for software position limiting.

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

▪ Allow sufficient space past the limit switch for your application to bring the axis to a standstill.
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Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration
according to your application. The default values are designed for slow velocities without gearboxes.

1. Select the Motor wizard.

2. B83 v-max motor:
Determine the maximum permitted velocity of the motor.

3. Select the Axis model wizard > Axis: Scaling.

4. Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the motor and the maximum permitted
velocity of the output as a reference value.

5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. I10 Maximal speed:
Define the maximum permitted velocity of the output according to your application (taking into account the
previously determined reference value).

7. I11 Maximal acceleration:
Define the maximum permitted acceleration for the output.

8. I16 Maximal jerk:
Define the maximum permitted jerk for the output.

9. I17 Quickstop deceleration: 
Define the desired quick stop deceleration for the output.

10. Repeat the steps for axis B (only for double-axis controllers).

Limiting the torque/force

As an option, you can limit the torque/force according to your application. The default values take into account the rated
operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. C03 Maximum positive torque/force, C05 Maximum negative torque/force:
Define the maximum permitted set torque/maximum permitted set force.

3. C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop and in case of drive-
controlled emergency stop SS1, SS1 and SS2.
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5.3 Referencing absolute position
When commissioning a system with position measurement systems, the relation of a measured to an actual axis position
must be determined to be able to work with absolute positions.

If you are working with absolute positions, reference the axis now. Otherwise, proceed by parameterizing application-
specific conditions and responses of the Drive Based device control.

WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

▪ Only execute this function if there are no slave axes coupled with the master.

Information

If you are using a double-axis controller with two projected axes, you must reference the absolute position for each axis
individually.

5.3.1 Defining the referencing method
1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.

2. Select the Referencing wizard.

3. I30 Referencing type, I31 Referencing direction, I35 Referencing with zero pulse:
Define the characteristics for referencing.
For information on possible combinations of the named characteristics as well as detailed descriptions of the
individual referencing methods, see Referencing methods [} 106].

4. I43 Move to reference position:
If the axis is to automatically move to the referenced position after referencing, set this parameter to 1: Active.

5.3.2 Parameterizing the reference switch
If you are working with absolute positions and would like to determine a reference position while referencing using the
reference switch, proceed as follows.

1. Select the Drive Based Synchronous application wizard > Data sources > Application digital signals: Data source.

2. I103 Source reference switch:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 3 of the control word I210 of the application is the source, select 2: Parameter.

5.3.3 Setting the reference
If you are working with absolute positions and would like to reference without using a referencing run, the value of the
current actual position is applied directly as a parameter value from I34 using the Set reference signal.

1. Select the Drive Based Synchronous application wizard > Data sources > Application digital signals: Data source.

2. I111 Source set reference:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 11 of the control word I210 of the Drive Based Synchronous application is the signal source, select 
2: Parameter.
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5.4 Parameterizing Drive Based device control
The Drive Based device control describes the control sequence of a drive controller based on a state machine, i.e. a drive
controller switches its state due to an event. Some of the conditions and responses coupled with the state transitions can
be influenced depending on the application; for example, it is possible to define the end of a quick stop or enable signal
delays tailored to the respective application case.

For more information on the device control and Drive Based device state machine, see Drive Based device control [} 133].

5.4.1 Parameterizing transition conditions

ü You have projected a drive controller with the Drive Based device control.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based device control wizard.

3. A34 Auto start:
If the drive controller is to switch directly to the Operation enabled state after the Switch on disabled state, activate
this parameter.

4. A43 Enable switch-on/off delay
If you need to hide possible fault or test pulses on the enable input, enter the maximum internal activation and
deactivation delay.

5. A44 Quick stop at enable off:
If the axis is to be stopped with a quick stop in the event of an Enable-off, activate this parameter.

6. A60 Source additional enable:
If you are working with multiple enable signals, select the source of additional signals in this parameter.

7. A29 Quick stop in case of fault:
If the axis is to be stopped with a quick stop – if possible – in case of a fault, activate this parameter. If the parameter
is deactivated, motion of the axis is no longer controlled by the drive controller.

8. A39 Maximum quick stop duration for enable off:
If you have selected 1: Active for parameter A44, define the maximum time after which the power unit is switched off
in A39.

9. A45 Quick stop end:
In this parameter, define whether a quick stop is considered ended when the axis is at a standstill or when the quick
stop request is canceled.

10. A62 Source /quick stop:
Select the source of the digital signal used to activate the quick stop.

11. If you are using a double-axis controller, click in the project menu > Wizard area on the second projected axis and
repeat the steps.
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5.5 Parameterizing synchronous operation
The following chapters describe the basic procedure for parameterizing the master and slave axes for synchronous
operation. Different configuration options are available in DriveControlSuite to operate one or more axes in synchronous
operation.

You can find more information on synchronous operation and the various configuration options under Synchronous
operation – Concept [} 95].

WARNING!

Injury to persons and material damage due to axis movement!

When referencing the master (axis, master encoder or virtual master) or using the preset function for phasing, the master
value changes immediately and without a motion profile. As a result, coupled slave axes immediately follow the motion of
the master.

▪ Only execute the functions if there are no slave axes coupled with the master.

Information

For double-axis controllers, the wizards for synchronous operation of both axes are coupled with each other. If you
configure parameter values for one of the two axes, these are automatically taken over at several places for the second
axis. Parameterizations that deviate from this are described in the following step-by-step instructions.

5.5.1 Scaling the master axis model
Scale the master axis model of the drive controller as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the wizard Drive Based Synchronous application > Synchronous operation > Master: Axis model, scaling.

3. G30 Position range master:
Define the travel range of the axis.

4. G40 Circular length master:
If you have selected 1: Endless for G30, define the master position from which counting begins again at zero.

5. G46 Decimal places:
Define the number of decimal places for specifying and displaying the master positions.

6. G49 Master measure unit:
Define the desired unit of measure for the master positions. Any unit of measure can be selected (max. 8 characters).

Information

A change to parameter G46 moves the decimal separator for all master position values. Therefore, change G46 before
parameterizing other master position values and then check them.

The resolution of master position values has a direct effect on the smooth operation of the coupled slave axes. Therefore,
define a sufficient number of decimal places appropriate for your application.
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5.5.2 Parameterizing the master axis
Parameterize the master axis according to your application as described below.

5.5.2.1 Parameterizing the master value source

Parameterize the master value source for the master axis as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the wizard Drive Based Synchronous application > Synchronous operation > Master.

3. G126 Source IGB producer position:
Define the master value source for the master axis.

3.1. If a master encoder is acting as the master value source, select 1: Master encoder.

3.2. If a virtual master is acting as the master value source, select 2: Virtual master.

3.3. If the actual position of the master axis is acting as the master value source, select 4: Actual position I80.

4. Select the Drive Based Synchronous application wizard > Synchronous operation > Slave.

5. G27 Source master position:
If the master axis itself is to follow the master value source, define the source for the master position.

5.1. If a master encoder is acting as the master value source, select 1: Master encoder.

5.2. If a virtual master is acting as the master value source, select 2: Virtual master.



5 | Commissioning STOBER

34

10
/2

02
5 

| 
ID

 4
43

05
9.

04

5.5.2.2 Parameterizing the virtual master

If a virtual master is used as the master value source, activate it in the first step and then limit the position, velocity,
acceleration and jerk for the virtual master.

Activating the virtual master

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions.

3. Activate the option Virtual master.

ð In the list of wizards, the Virtual master wizard is displayed.

Information

To be able to control the additional virtual master function via fieldbus, expand the process data mapping using the
respective wizard (EtherCAT: Received process data RxPDO; PROFINET: Received process data RxPZD).

An overview of the virtual master parameters that can be written by the controller via fieldbus is provided by the Command
operating mode: Virtual master wizard. Add the required parameters to both the receive process data of the drive
controller and the transmit process data of the controller (motion command: G483; set value specifications: G484 – G488;
control words: G10, G12).

Parameterizing the virtual master

ü You have activated the additional virtual master function.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Limit: virtual master.

3. G53 Virtual master move direction:
If you selected 1: Endless for G30 when parameterizing the master axis model, you define the permitted direction of
motion for the virtual master.

3.1. If motions in both directions are permitted, select 0: Positive and negative.

3.2. If motions are only permitted in one direction, select 1: Positive or 2: Negative accordingly.

4. G50 Virtual master maximal speed:
Define the maximum velocity of the virtual master.

5. G51 Virtual master maximal acceleration:
Define the maximum acceleration of the virtual master.

6. G54 Virtual master quickstop deceleration:
Define the maximum quick-stop acceleration of the virtual master.

7. G52 Virtual master maximal jerk:
Define the maximum jerk of the virtual master.
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Information

The limiting values for the velocity, acceleration, quick stop and jerk of the virtual master (G50, G51, G52, G54) depend on
the limiting values of the slave axes.

To determine the maximum velocity for the virtual master, for example, convert the maximum velocity of each individual
slave axis together with the respective gear ratio I417 Gear ratio numerator and I418 Gear ratio denominator into an
alternative maximum velocity. The slave axis with the lowest maximum velocity is simultaneously the velocity limit value of
the virtual master.

Proceed in the same manner for the limit values for acceleration, quick stop and jerk.

Virtual master: Limiting the travel range

ü You have activated the additional virtual master function.

ü The travel range of the master is limited (G30 = 0: Limited).

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Limit: virtual master.

3. G146 Virtual master software limit switch +, G147 Virtual master software limit switch -:
In order to protect the travel range, limit the position of your axis if necessary using a positive or negative software
limit switch.

4. Select the Protection functions wizard.

5. U24 Level virtual master limit switch: 
Select 3: Fault.

6. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master.

7. G57 Virtual master quickstop additional source:
Select 1: Error or 3: Enable or error.

8. G56 Virtual master quickstop additional source axis select:
If you are using a double-axis controller, select 0: Axis A.

ð If the software limit switches are overshot, a quick stop of the virtual master is triggered.
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5.5.2.3 Parameterizing the master encoder

If a master encoder is used as the master value source, activate the interface you used to connect the master encoder to
the drive controller in the first step and then parameterize the master encoder together with the encoder interface.

Parameterizing the master encoder

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Encoder wizard > Master encoder: Scaling.

3. G104 Source master encoder:
Select the interface over which the master encoder is connected.

4. G47 Distance factor numerator master, G48 Distance factor denominator master:
Define the conversion factor for the path of the master encoder in relation to the master position.

5. Select the Encoder wizard.

6. G297 maximum-speed master-encoder
Define the maximum permitted velocity for the master encoder.

Information

Parameterize G297 maximum-speed master-encoder according to your application case: If G297 is set too low, the
permitted maximum speed is exceeded even at normal operating speeds. If G297 is set too high, measuring errors of the
encoder can be overlooked.

G297 depends on the following parameters: G46 Decimal places, G47 Distance factor numerator master, G48 Distance
factor denominator master and G49 Master measure unit. If you have made changes to one of the parameters listed, adjust
G297 accordingly as well.

Master encoder: Parameterizing the interface

ü You have selected the interface for the master encoder (G104 ≠ 0: Inactive).

1. If you have connected the master encoder over the X4 interface, select the Encoder wizard > X4.

1.1. H00 X4 function:
Select the encoder model that is connected to the interface.

ð The appropriate parameters are displayed based on the selected encoder model.

1.2. H03 Encoder version:
Select whether the encoder design is rotational or translational.

1.3. Parameterize the interface according to the properties of the master encoder.

2. If you have connected the master encoder over the X101 or X103 (DI) interface, select the Encoder wizard > X101/
X103 (DI).

2.1. H40 DI encoder:
Select the encoder model that is connected to the interface.

ð The appropriate parameters are displayed based on the selected encoder model.

2.2. H43 Encoder version:
Select whether the encoder design is rotational or translational.

2.3. H41 DI numerator, H42 DI denominator:
Parameterize the pair of values for scaling the encoder at the digital input.
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5.5.3 Parameterizing slave axes
Parameterize the slave axes according to your application as described below.

5.5.3.1 Parameterizing the master value source

Parameterize the master value source for the slave axes as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select Drive Based Synchronous application > Synchronous operation > Slave.

3. G27 Source master position:
Select the desired master value source.

3.1. If a master encoder is acting as the master value source, select 1: Master encoder.

3.2. If a virtual master is acting as the master value source, select 2: Virtual master.

3.3. If the actual position of the master axis is acting as the master value source, select 6: IGB motion bus.

5.5.3.2 Parameterizing the electronic gearbox

For the slave axes, optionally define a factor for the gear ratio of the electronic gearbox.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the wizard Drive Based Synchronous application > Synchronous operation > Electronic gear unit.

3. I418 Gear ratio denominator, I417 Gear ratio numerator:
Define a factor for the gear ratio of the master position and axis movement in the form of a quotient (numerator and
denominator).

4. If you are using a double-axis controller, define a factor for the gear ratio for the second axis as well: Click on the
second projected axis in the project menu > Wizard area and repeat the steps.
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5.5.4 Monitoring synchronous operation
In synchronous operation, you have the option to monitor whether selected slave axes are still running synchronously with
the master. As soon as a monitored slave axis is no longer synchronous, a quick stop can bring the master to a standstill and
thus also stop all slave axes.

Information

When monitoring synchronous operation, an override function is available for commissioning, emergency operation or
maintenance and repair work. You can use this to temporarily deactivate the quick-stop behavior of the master that is
defined in parameter G108 (override: G116).

Information

An axis is considered synchronous if it has the status I89 = 5: Synchronous motion. This does not take into account whether
the source for the master position is inactive, for example, or whether a factor of 0 or an override of 0% has been
parameterized for the ratio of the electronic gearbox (master position source: G27; gear ratio: I417, I418; override: G116).

Double-axis controller: Monitoring synchronous operation

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the project menu >
Parameter list area.

2. G109 Sync monitoring enable:
To activate synchronous operation monitoring for the respective axis, select 1: Active.

ð The function is active and the associated parameters are displayed.

3. G107 Sync status word address:
Define the bit position in the status word for synchronous operation to which the synchronous state of the axis is
written.

4. G108 Sync monitoring quick stop:
Select how the master is to behave if one of the monitored axes is no longer synchronous.

4.1. If a virtual master is acting as the master value source, select 1: Quick stop VM.

4.2. If a master encoder or the axis model of the master axis is acting as the master value source, select 2: Quick
stop axis.

5. G111 Sync monitoring selection:
Select the axes whose synchronous state is to be monitored.
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5.6 Transmitting and saving a configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

5.6.1 Transmitting the configuration
The steps for transmitting the configuration vary depending on the safety technology.

Drive controller without SX6 option (extended safety technology)

ü The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection
of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configurations are transferred to the drive controllers.
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Drive controller with SX6 option (extended safety technology)

ü The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column:
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection
of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configurations are transferred to the drive controllers.

ð The PASmotion Safety Configurator configuration tool opens.

1. In the project administration, navigate from PASmotion Safety Configurator to the safety module for the drive
controller and double-click to open it.

ð The wizard for device synchronization opens.

ð The project configuration and device configuration are checked against each other.

2. If the configurations match, click Done after device synchronization has finished.

3. Optional: If the configurations do not match, click Next after device synchronization has finished.

3.1. Confirm the serial number of the safety module and click Next.

3.2. Enter the password for the configuration on the safety module and click Next.

3.3. Click Download.

ð The project configuration is transferred to the safety module.

3.4. After the successful transfer, click Done.

4. Home page, CRC safety configuration:
Document the checksum of the safety functions in the machine documentation.

5. Repeat the steps for each additional safety module in your project.

6. Exit PASmotion Safety Configurator.

ð Transfer of the configuration is completed.

Information

If you do not know the password for the configuration on the safety module and would like to send a new safety
configuration, you can delete the safety configuration on the safety module in DriveControlSuite using parameter S33.
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5.6.2 Saving the configuration

ü You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Select on which drive controllers you want to save the configuration.

3. Click Start action.

ð The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart may be required in certain cases, such as after the
configuration is saved on the drive controller for the first time or when changes are made to the firmware or process data
mapping.

Restarting a drive controller

ü You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety note with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð The selected drive controllers restart.

5.7 Testing the configuration
After you have transferred the configuration to the drive controller, first check your projected axis model and the
parameterized electrical and mechanical data for plausibility before continuing with the parameterization.
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5.7.1 Testing jog mode
Jog control panel provides various commands for jog mode which you can use to test the configuration of your projected
axis model for plausibility.

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the jog control panel

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have successfully stored the configuration on the drive controller.

ü No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis gradually using
the Jog+, Jog-, Jog step+ and Jog step- buttons.

6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.
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5.7.2 Testing the motion commands
Control panel motion provides a standard set of motion commands which you can use to test the basic movements of your
axis. The command set is based on the PLCopen standard and supplemented by manufacturer-specific motion commands.

If you are working with absolute position measuring systems and need the MC_MoveAbsolute motion command for
testing, you must reference an absolute position in advance (see Referencing absolute position [} 30]).

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the motion control panel

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have successfully stored the configuration on the drive controller.

ü No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Control panel motion wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. K402 Command: 
Select the desired command and define the position, velocity, acceleration, deceleration and jerk.

6. Execute the command by clicking Start.

7. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis precisely using the
individual commands.

8. Use your test results to optimize your configuration as necessary.

9. To deactivate the control panel, click on Control panel off.
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5.7.3 Testing synchronous operation
If you are working with a virtual master or master encoder as the master value source, first reference its absolute position
and test its functionality. Then, check the functionality of the master/slave coupling (GearIn).

5.7.3.1 Referencing and testing the virtual master

If you are working with a virtual master as the master value source, reference it and test its functionality using the Control
panel motion: Virtual master wizard.

WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

▪ Only execute this function if there are no slave axes coupled with the master.

Referencing the virtual master

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have completed the configuration for synchronous operation and saved it on the drive controller.

ü No safety function is active.

1. Select the master drive controller in the project tree and click on the desired projected axis in the project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Control panel motion:
Virtual master.

3. Activate the control panel by clicking Control panel on.

ð The control panel is active: The parameters and buttons which you can use to control the virtual master are
displayed.

4. In order to reference the actual position of the virtual master manually, click Set pos.

ð The value of parameter G58 Virtual master preset position is transmitted to parameter G190 Actual position
virtual master.
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Testing the virtual master

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have completed the configuration for synchronous operation and saved it on the drive controller.

ü No safety function is active.

1. Select the master drive controller in the project tree and click on the desired projected axis in the project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Control panel motion:
Virtual master.

3. Activate the control panel by clicking Control panel on.

ð The control panel is active: The parameters and buttons which you can use to control the virtual master are
displayed.

4. To test the virtual master, assign values to the following parameters.

5. G483 Virtual master command:
Select the motion command you would like to use to move the virtual master.

6. G484 Virtual master target position:
Define the set position to which the virtual master is to travel.

7. G485 Virtual master velocity:
Define the set velocity at which the virtual master is to travel.

8. G486 Virtual master acceleration:
Define the acceleration at which the virtual master is to travel.

9. G487 Virtual master deceleration:
Define the deceleration at which the virtual master is to travel.

10. G488 Virtual master jerk:
Define the jerk at which the virtual master is to travel.

11. To execute the motion command, click on Start.

ð The values of parameters G190 Actual position virtual master, G191 Actual velocity virtual master and
G159 Virtual master PLCopen-state change according to the parameterization.

Information

The values of Control panel motion: Virtual master for the set velocity, acceleration and jerk of the virtual master are
limited using the Limit: virtual master wizard (parameters G485, G486 and G488 or parameters G50, G51 and G52).
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5.7.3.2 Referencing and testing the master encoder

If you are working with an external master encoder as the master value source, reference it and test its function by moving
it manually.

WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

▪ Only execute this function if there are no slave axes coupled with the master.

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have completed the configuration for synchronous operation and saved it on the drive controller.

ü No safety function is active.

1. Select the master drive controller in the project tree and click on the desired projected axis in the project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Synchronous operation > Master digital signals: Data source.

3. G453 Source master reference set: 
Enter the signal source for triggering the referencing.

4. To reference the master encoder, trigger the referencing signal.

5. Select the Drive Based Synchronous application wizard > Synchronous operation > Master.

6. Move the master encoder mechanically.

ð The value of parameter G122 Lead-position producer changes according to the movements of the master encoder.

5.7.3.3 Testing the master/slave coupling

Test the master/slave coupling using Control panel motion and the 12: MC_GearIn motion command.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.
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Information

To prevent an enabled axis from moving unnoticed in the background, active control panels are deactivated as soon as you
open a new wizard.

To test the master/slave coupling (Gear-In), you need multiple control panels at the same time. Therefore, open all
necessary wizards in the first step. In the second step, arrange them next to each other in window mode and only activate
the required control panels in the third step.

Opening wizards

1. Select the desired drive controller in the project tree and click on the master axis in the project menu > Wizard area.

2. Open the wizard according to the master value source.

2.1. Virtual master:
Select the Drive Based Synchronous application wizard > Additional functions > Virtual master > Jog control
panel: Virtual master.

2.2. Master encoder:
Select the Drive Based Synchronous application wizard > Synchronous operation > Master.

2.3. Motor axis model of the master axis:
Select the Drive Based Synchronous application wizard > Jog control panel.

3. Select the desired drive controller in the project tree, hold down [CTRL] and click on the first slave axis in the project
menu > Wizard area.

4. Select the Control panel motion wizard.

5. If you are using a double-axis controller and both axes are running in synchronous operation, repeat the steps for the
second axis.

6. Select Windows in the menu bar > Show windows side by side.

ð The wizards are arranged next to each other.

ð You can now move the master and check the behavior of the slaves at the same time without the control panels being
automatically deactivated.

Coupling the slave axis

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have completed the configuration for synchronous operation and saved it on the drive controller.

ü You have opened all necessary wizards and arranged them next to each other in window mode.

1. Select the previously opened Control panel motion wizard of the slave axis.

2. Activate the control panel by clicking Control panel on.

ð The control panel is active: The parameters and buttons which you can use to move the axis are displayed.

3. K402 Command: 
Select 12: MC_GearIn.

4. Click on Start.

ð Parameter E80 Operating condition indicates the state 29: Synchronous motion.

ð The slave axis is active and coupled to the master.

5. If you are using a double-axis controller and both axes are running in synchronous operation, repeat the steps for the
second axis.
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Moving the master

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have completed the configuration for synchronous operation and saved it on the drive controller.

ü You have opened all necessary wizards and arranged them next to each other in window mode.

1. Open the wizard according to your master value source.

2. Virtual master:

2.1. Select the previously opened Jog control panel: Virtual master wizard.

2.2. Activate the control panel by clicking Control panel on.

2.3. Move the virtual master by using the jog method.

ð The value in parameter G190 changes according to the position of the virtual master.

3. Master encoder:

3.1. Select the previously opened Master wizard.

3.2. Move the master encoder mechanically.

ð The value in parameter G122 changes according to the position of the master encoder.

4. Motor axis model of the master:

4.1. Select the previously opened Jog control panel wizard of the master axis.

4.2. Activate the control panel by clicking Control panel on.

4.3. Move the master axis by using the jog method.

ð The value in parameter I80 changes according to the position of the master axis.

ð The actual position of the slave axis changes depending on the master position (Control panel motion wizard,
parameter I80).
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5.8 Parameterizing the Drive Based Synchronous application
The Drive Based Synchronous application provides two operating modes: Command operating mode and motion block
operating mode

The operating modes provide you with a standard set of motion commands based on PLCopen that are supplemented with
unique motion commands. The operating mode that is best suited to your application depends on your application case. If
you are coordinating motion sequences using a controller, use the command operating mode. If you are not using a
controller and are instead storing the motion profiles on the respective drive controller, use the motion block operating
mode.

The general motion variables are grouped in the mode-independent Data sources wizard. Depending on the operating
mode, unique wizards are also available which you can use to parameterize operating mode-specific motion variables. The
general or operating mode-specific motion variables you need to parameterize depend on your drive project.

If you would like to use set values from external sources for your project, parameterize them in the first step. Then,
continue with the operating mode-specific motion variables in the respective wizards.

Information

A drive controller can only process the motion commands of one operating mode for each projected axis. If you are using a
double-axis controller with two projected axes, you must configure the operating mode for each axis individually.

To configure the Drive Based Synchronous application, follow the handling instructions for the operating mode in which you
want to operate the corresponding axis.

5.8.1 General motion variables and signal sources
First, parameterize the general motion variables and signal sources before you begin parameterization of the operating
mode-specific motion variables. The motion variables that you need to parameterize depend on your drive project.

Information

If you are using a double-axis controller with two projected axes, you must configure the shared motion variables and signal
sources for each axis individually.
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5.8.1.1 Velocity – Parameterizing sources

If you are obtaining the set value for velocity from external sources for applications of the Drive Based Synchronous type,
enter this as described below.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

Set velocity – Parameterizing the source

If you are obtaining the set value for velocity from an external source, enter the source for the main set value.

ü Use the motion command MC_MoveSpeed or MC_MoveVelocity.

1. Select the Drive Based Synchronous application wizard > Data sources > External velocity: Data source.

2. G461 Source external velocity:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G460.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter G811.

3. G460 External velocity:
If you have selected 4: Parameter G460 for G461, enter the set velocity here.

4. G811 Indirect read external velocity:
If you have selected 5: Indirect read parameter G811 for G461, enter the associated parameter coordinate here.

Additional velocity – Parameterizing the source

If you also want to regulate the set velocity, enter the source for the additional set value.

ü Use the motion command MC_MoveSpeed or MC_MoveVelocity.

ü You obtain the set velocity from an external source.

1. Select the Drive Based Synchronous application wizard > Data sources > External additional velocity: Data source.

2. G464 Source external additional velocity:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G463.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter G812.

3. G463 External additional velocity:
If you have selected 4: Parameter G463 for G464, enter the set velocity here.

4. G812 Indirect read additional external velocity:
If you have selected 5: Indirect read parameter G812 for G463, enter the parameter coordinate here.
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5.8.1.2 Velocity override – Parameterizing the source

If you would like to use a velocity override to scale the velocity profile of your motion commands, enter the source for the
velocity override.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

1. Select the Drive Based Synchronous application wizard > Data sources > Velocity override: Data source.

2. G467 Source velocity override:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G466.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter G813.

3. G466 Velocity override:
If you have selected 4: Parameter G466 for G467, enter the set velocity here.

4. G813 Indirect read velocity override:
If you have selected 5: Indirect read parameter G813 for G467, enter the parameter coordinate here.

5.8.1.3 Torque/Force – Parameterizing sources

If you have selected the motion command MC_TorqueControl for Drive Based Synchronous type applications and obtain set
values from external sources, enter the sources for the set torque/force and velocity bracketing.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

Set torque/force – Parameterizing the source

If you obtain the set value for torque/force from an external source, enter the source for the set torque/force.

ü You are using the 9: MC_TorqueControl motion command.

1. Select the Drive Based Synchronous application wizard > Data sources > Set torque/force, velocity bracketing: Data
source.

2. G470 Source torque/force reference:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G469.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter G814.

3. G469 Torque/Force reference:
If you have selected 4: Parameter G469 for G470, define the value for set torque/force here. The value relates to
C03 Maximum positive torque/force and C05 Maximum negative torque/force.

4. G814 Indirect read torque/force reference:
If you have selected 5: Indirect read parameter G814 for G470, define the associated parameter coordinate here.

5. G500 Torque/force ramp removal, G501 Torque/force ramp removal:
Define the ramps for the build-up or reduction of torque/force.
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Velocity bracketing – Parameterizing the source

If you obtain values for limiting the velocity from an external source, enter the source for the velocity bracketing.

ü You are using the 9: MC_TorqueControl motion command.

1. Select the Drive Based Synchronous application wizard > Data sources > Set torque/force, velocity bracketing: Data
source.

2. G473 Source velocity bracketing positiv:

2.1. If you are transmitting data via fieldbus, select 4: Parameter G472.

3. G472 Velocity bracketing positiv:
If you have selected 4: Parameter G472 for G473, define the maximum limit that you want to permit for your
mechanical system.

4. G476 Source velocity bracketing negative:

4.1. If you are transmitting data via fieldbus, select 4: Parameter G475.

5. G475 Velocity bracketing negative:
If you have selected 4: Parameter G475 for G476, define the maximum limit that you want to permit for your
mechanical system here.

Information

If you define the velocity bracketing using G472 or G475, you should allow the control enough room. Therefore, select a
value for the velocity bracketing that is greater than 1%. Values less than 1% are internally set to 1% and values greater
than 100% are internally set to 100%. G472 and G475 refer to I10 Maximal speed.
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5.8.2 Parameterizing motion block operating mode
The following graphic shows the signal flows of motion block operating mode. The elements shown in a lighter shade are
optional.

Controller
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Fig. 3: Motion block operating mode: Signal flows

In the motion block operating mode, motion profiles are permanently stored on the drive controller in the form of motion
blocks. A motion block includes a PLCopen-compliant motion command which defines the basic motion method of the axis.
The associated motion variables supply specifications on velocity, acceleration, deceleration and jerk, which the motion
core of the drive controller uses to calculate the motion profile.

Motion blocks can be selected individually using motion block numbers and they can be linked with each other, i.e. they are
automatically processed in succession. In motion block linking, a linear, defined sequence as well as branches based on
conditions are both possible for the further motion block continuation. You can parameterize specifications on velocity
override and brake for each motion block individually.

In motion block operating mode, drive controllers are either activated using a fieldbus or by a mixed operation of a fieldbus
and terminals. The number of axes and motion blocks used determines the memory you need for your project.

Information

The motion variables available for this operating mode that you configure in the software depend on your application case
as well as on additional project-specific factors such as the use of a controller or the type of data transmission (fieldbus,
terminals).
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Proceed as follows ...

§ Activate motion block operating mode.

§ Parameterize one or more motion blocks.

§ Test the individual motion blocks using the motion block control panel.

§ If you want to link motion blocks with each other, define subsequent motion blocks and triggers for continuation.

§ Test the motion block links using the motion block control panel.

§ Define how the motion blocks are started.

§ Parameterize the source for the continue, reset and, if necessary, stop signals.

5.8.2.1 Activating motion block operating mode

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard.

3. Operating modes area:
Activate the Motion block operating mode option.

ð The corresponding wizards are displayed.

5.8.2.2 Limiting the torque/force using the operating mode

Basic torque/force limiting using the mechanical system takes place in the project configuration of the axis model. As an
option, you can parameterize an additional torque/force limit via the operating mode, either for all motion blocks together
or for each motion block individually.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Torque/force
limit: Data source.

2. J08 Source maximum T/F:

2.1. If you would like to specify the maximum value from the axis model for all motion blocks centrally, select 
3: 100%.

2.2. If you would like to specify the maximum value using the operating mode for all motion blocks centrally, select
1: Parameter J09.

2.3. If you would like to define an individual maximum value for each motion block, select 2: Parameter J25.

3. J09 Maximum torque/force:
If you have selected 1: Parameter J09 for J08, enter the maximum permitted value for torque/force.

4. If you have selected 2: Parameter J25 for J08, enter the maximum permitted value for torque/force during the
parameterization of individual motion blocks in J25 Maximum torque/force.
To do so, proceed as described in the chapter Parameterizing the motion block [} 55].

Information

The mechanical torque/force limit is executed using the axis model (limit: C03 and C05). Additional limiting through the
operating mode is optional and applies to the maximum permitted values for torque/force that you defined in the axis
model (reference values: C03, C05).
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5.8.2.3 Parameterizing motion blocks

Before you start parameterizing the individual motion blocks, determine whether you also want to limit torque/force using
the operating mode. You have already defined the maximum value for torque/force in the axis model, but you have the
option of specifying an additional limit for all motion blocks together or for each motion block individually.

For each motion block, select an appropriate motion command and parameterize the associated motion variables. You can
copy parameterized motion blocks completely to create other motion blocks.

Then, test the parameterization of the individual motion blocks using Motion block control panel.

Information

Before you start parameterizing the operating mode-specific motion variables, parameterize the general motion variables
and signal sources. If you obtain set values for velocity, velocity override or torque/force for your drive project from
external sources, proceed as described in the chapter General motion variables and signal sources [} 49].

5.8.2.3.1 Parameterizing the motion block

To parameterize a motion block, first select the desired motion command, then parameterize the associated motion
variables according to your drive project.

ü You have activated motion block operating mode.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode.

ð By default, 16 motion blocks are available to you which you can parameterize individually.

2. To parameterize the first motion block, click its motion block number in the Number column.

ð The details view for the first motion block is displayed.

3. J10 Name: 
Define the name of the motion block.

4. J11 Command: 
Select the desired motion command.

ð The associated parameters are displayed.

5. J25 Maximum torque/force:
If you have also limited torque/force using the operating mode and have selected 2: Parameter J25 for J08, enter the
maximum permitted value for torque/force for each motion block.

6. Parameterize the selected motion command based on its associated parameter.

Information

Using J28 Velocity override enable, you activate the scaling of the velocity profile of a motion block. For motion blocks with
final velocity, the velocity override influences J14 Velocity and J18 End velocity equally, i.e. the relationship between J14
and J18 remains the same.

Information

Use J21 Command Mode to define how the motion block, as the subsequent motion block, is executed for motion block
linking. If you select 0: Abort current command, the ongoing motion block is interrupted when the trigger is activated and
the subsequent motion block is executed immediately. If you select 1: Start when current command has finished, the
ongoing motion block is completed first before the subsequent motion block is started.
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Moving the axis with a set velocity

ü You have selected the motion command MC_MoveSpeed or MC_MoveVelocity.

1. J30 Source velocity:
Select the source from which you will obtain the set value for the velocity.

1.1. If you obtain the set value via fieldbus, select 0: Parameter J14.

1.2. If you obtain the set value from an external source, select 1: Parameter G462.

2. J14 Velocity:
If you have selected 0: Parameter J14 for J30, enter the set velocity.

3. J15 Acceleration, J16 Deceleration, J17 Jerk: 
Enter the set values for acceleration, deceleration and jerk.

4. J28 Velocity override enable: 
If you would like to apply a velocity override to the motion block, select 1: Active.

5. J21 Command Mode:
Select the mode in which the selected motion block, as the subsequent motion block, is to be executed.

Moving the axis with a set torque/force

ü You have selected the motion command MC_TorqueControl.

1. J32 Source reference torque/force: 
Select the source from which you will obtain the set value for torque/force.

1.1. If you obtain the set value via fieldbus, select 0: Parameter J26.

1.2. If you obtain the value from external sources, select 1: Parameter G471.

2. J26 Torque/Force reference:
If you have selected 0: Parameter J26 for J32, enter the set torque or set force.

3. J16 Deceleration, J17 Jerk:
Enter the set values for deceleration and jerk.

4. J28 Velocity override enable: 
If you would like to apply a velocity override to the motion block, select 1: Active.

5. J21 Command Mode:
Select the mode for the motion block in which it, as the subsequent motion block, is to be executed.
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Moving the axis to the set position

ü You have selected the motion command MC_MoveAbsolute, MC_MoveAdditive or MC_MoveRelative.

1. J13 Position:
Enter the absolute or relative position to which the axis is to be moved.

2. J14 Velocity:
Enter the set value for the velocity.

3. J15 Acceleration, J16 Deceleration, J17 Jerk: 
Enter the set values for acceleration, deceleration and jerk.

4. J18 End velocity:
Enter the final velocity with which you want to reach the set position J13.

5. J24 Waiting time at the end:
If a subsequent motion block is not to be started immediately, enter the wait time at the end of the motion block.

6. J27 Engage brake at the end:
If you have parameterized a brake and it is to engage at the end of the motion block, select 1: Active.

7. J28 Velocity override enable: 
If you would like to apply a velocity override to the motion block, select 1: Active.

8. J21 Command Mode:
Select the mode for the motion block in which it, as the subsequent motion block, is to be executed.

Information

For motion blocks with a final velocity that is not 0, a change of travel direction by the subsequent motion block is not
permitted.

Referencing the axis

ü You have selected the motion command MC_Home.

1. I30 Referencing type:
Indicates what referencing type you have parameterized for the referencing process.

2. J16 Deceleration, J17 Jerk:
Enter the set values for deceleration and jerk with which the axis is stopped if referencing is interrupted by a control
panel.

3. J24 Waiting time at the end:
If a subsequent motion block is not to be started immediately, enter the wait time at the end of the motion block.

4. J27 Engage brake at the end:
If you have parameterized a brake and it is to engage at the end of the motion block, activate J27.

5. J28 Velocity override enable: 
If you have parameterized a velocity override and would like to apply it to the motion block, select 1: Active.

Information

To parameterize the referencing process, click the Referencing link and proceed as described in the chapter Referencing
absolute position [} 30].
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Stopping the axis

ü You have selected the motion command MC_Halt or MC_Stop.

1. J16 Deceleration, J17 Jerk:
Enter the set values for deceleration and jerk with which the axis is stopped.

2. J24 Waiting time at the end:
If a subsequent motion block is not to be started immediately, enter the wait time at the end of the motion block.

3. J27 Engage brake at the end:
If you have parameterized a brake and it is to engage at the end of the motion block, activate J27.

Move the axis synchronously

ü You have selected the motion command MC_GearIn or MC_GearInPosition.

1. J15 Acceleration, J16 Deceleration, J17 Jerk: 
Enter the set values for acceleration, deceleration and jerk.

2. J13 Position:
If you have selected MC_GearInPosition, enter the position of the axis from which the axis is to move synchronously
with the master.

3. J20 Position D (Master Sync Position):
If you have selected MC_GearInPosition, enter the position of the master from which the axis is to move
synchronously with the master.

4. J28 Velocity override enable: 
If you would like to apply a velocity override to the motion block, select 1: Active.

Information

To decouple a slave axis from synchronous operation, you can use the motion commands MC_GearOut or MC_Halt, for
example. MC_GearOut decouples the axis and retains the last velocity before decoupling; MC_Halt brings the axis to a
standstill after decoupling.
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5.8.2.3.2 Parameterizing the motion block duration

If you are using an endless motion command to move the axis with a set velocity or set torque/force, for example, you can
switch to a subsequent motion block after a defined time using the additional motion block duration function and an
indirect trigger.

ü You are using an endless motion command.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block >
Indirect trigger: Data source.

2. Activate the Motion block duration option.

ð The additional function is activated and the associated parameter J452 FSM block duration is shown in the Motion
block wizard.

3. Click on the Motion block link.

ð The Motion block wizard opens.

4. Number:
Use the arrow keys to select the number of the motion block for which you would like to define a motion block
duration.

5. J452 FSM block duration:
Enter the duration for which the motion block is to be executed.

Information

As soon as the motion block duration is reached, the information is stored in bit 0 of parameter J453 FSM end of block
duration. To continue on to a subsequent motion block once the motion block duration is reached, parameterize a
subsequent motion block using the interrupt signal with an indirect trigger as described in Parameterizing the subsequent
motion block with a trigger [} 61].

5.8.2.3.3 Copying a motion block

To make parameterization of similar motion blocks easier, you can apply the values from existing motion blocks.

ü You are in the Motion block wizard.

ü You have parameterized at least one motion block.

1. Number:
Select the number of the motion block to which you want to copy the values from an existing motion block.

2. Apply from:
Click on Apply from and select the existing motion block whose values you want to copy.

3. Confirm by clicking on OK.

ð The values of the existing motion block are applied to the current motion block.

4. Adjust the copied values, such as J10 Name, if necessary.
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5.8.2.3.4 Testing the motion block parameterization

Motion block control panel provides all functions you need to test the parameterization of individual motion blocks.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

ü The drive controller is switched on.

ü You have established an online connection to the drive controller.

ü You have parameterized at least one motion block.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block control panel.

2. Click Control panel on and then Enable.

ð The drive is controlled using the active control panel.

3. J311 Motion block selection:
Select the motion block whose parameterization you would like to test.

4. Test the positions, velocities, accelerations and brakes and optimize your parameterization based on your test results
if necessary.

5. If you want to link motion blocks with each other as subsequent motion blocks, first test the parameterization for each
motion block individually to be able to rule out errors in motion block linking.

6. In order to deactivate the control panel, click Control panel off.



STOBER 5 | Commissioning
10

/2
02

5 
| 

ID
 4

43
05

9.
04

61

5.8.2.4 Parameterizing motion block linking

In order to configure rolling programs automatically, you can connect multiple motion blocks with each other in sequence.
To do so, link the motion blocks in question with each other as subsequent motion blocks and enter the associated signal
sources for continuation. The subsequent motion blocks that are assigned to a motion block are displayed in the motion
block overview.

Then, test the linking of the individual motion blocks using Motion block control panel.

5.8.2.4.1 Parameterizing subsequent motion blocks

You can define one or more possible subsequent motion blocks for each motion block. Continuation to the subsequent
motion block either happens automatically at the end of the motion block or is caused by a trigger. The trigger can either be
a direct trigger signal or a trigger condition that is configurable in the software (indirect trigger). Buffered subsequent
motion blocks are parameterized without triggers and are intended for the case where the axis is moved to a set position in
the previous motion block that is reached with the final velocity.

You can find more information on motion block linking and subsequent motion block under Motion block [} 77].

5.8.2.4.1.1 Parameterizing the subsequent motion block with a trigger

You can define up to five subsequent motion blocks that are each activated by a trigger signal or trigger condition (indirect
trigger) for each motion block in the Subsequent motion block wizard. Depending on the configuration, the subsequent
motion block is only executed at the end of the previous motion block, or the ongoing motion block is interrupted when an
interrupt signal is triggered or an interrupt condition occurs and the subsequent motion block is started.

For each subsequent motion block, define the signal sources for continuation by parameterizing either a direct trigger signal
or an indirect trigger condition. You can configure multiple triggers for each motion block. Each trigger can either activate a
subsequent motion block through interruption or a subsequent motion block at the end of the previous motion block. If
multiple triggers are active simultaneously, the sequence continues with the subsequent motion block with the highest
priority (A – E).

Information

Depending on the application case, you can either parameterize a regular subsequent motion block or a buffered
subsequent motion block at the end of the previous motion block. The use of a regular subsequent motion block at the end
rules out the simultaneous use of a buffered subsequent motion block for the same motion block, and vice versa. You can
combine subsequent motion blocks through interruption with regular subsequent motion blocks at the end and with
buffered subsequent motion blocks.

Information

J450 Source trigger and J439 Source indirect trigger are array parameters. The first element (J450[0], J439[0]) corresponds
to trigger 1, the second element (J450[1], J439[1]) corresponds to trigger 2, etc.
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Parameterizing the subsequent motion block at the end of motion block

Use subsequent motion blocks at the end of the motion block if you want to move the axis with a finite motion command
and automatically switch to the subsequent motion block when the specified set value is reached.

The following section explains the process as an example, based on the parameterization of subsequent motion block A. For
the parameterization of subsequent motion block B – E, proceed in the same manner.

ü You have parameterized at least two motion blocks.

ü You are moving the axis with MC_MoveAbsolute, MC_MoveRelative or MC_MoveAdditive in the motion block to
which you would like to add a subsequent motion block.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block.

2. Number:
Use the arrow keys to select the number of the motion block to which you would like to add a subsequent motion
block.

3. J281 Next motion block A at end:
If the subsequent motion block is to be executed once the motion block selected in Number has been completed,
select the subsequent motion block here.

4. J251 Source trigger next motion block A: 
Select the trigger that activates continuation to the subsequent motion block.

5. Click on the Trigger: Source link.

ð The Trigger: Data source wizard opens.

6. J450[0] Source trigger:
Select the source of the trigger signal used to start the subsequent motion block.

6.1. If you would like the subsequent motion block to be activated directly at the end of the previous motion block,
select 1: High.

6.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

6.3. If the subsequent motion block is to be executed when a configurable condition is fulfilled (indirect trigger),
select 2: Parameter and proceed as described in the section Parameterizing the indirect trigger.

Information

For subsequent motion blocks at the end of the motion block, the trigger condition is only evaluated at the end of the
ongoing motion block by using J281 – J285. Since the evaluation only takes place at the motion block end, J21 Command
Mode does not influence when the subsequent motion block is started. The subsequent motion block always starts at the
motion block end if the trigger condition is active.
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Parameterizing the subsequent motion block due to interruption

Use subsequent motion blocks due to interruption if you would like to interrupt the ongoing motion block when the trigger
is activated and continue to the subsequent motion block.

The following section explains the process as an example, based on the parameterization of subsequent motion block A. For
the parameterization of subsequent motion block B – E, proceed in the same manner.

ü You have parameterized at least two motion blocks.

ü You have selected 0: Abort current command for the subsequent motion block in J21 Command Mode.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block.

2. Number:
Use the arrow keys to select the number of the motion block to which you would like to add a subsequent motion
block.

3. J271 Next motion block A by interrupt:
If the subsequent motion block is to be executed as soon as the motion selected in Number is interrupted by an
interrupt signal, select the subsequent motion block here.

4. J251 Source trigger next motion block A: 
Select the trigger that activates continuation to the subsequent motion block.

5. Click on the Trigger: Source link.

ð The Trigger: Data source wizard opens.

6. J450[0] Source trigger:
Select the source of the trigger signal that activates continuation to the subsequent motion block.

6.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

6.2. If the subsequent motion block is to be executed when a configurable condition is fulfilled (indirect trigger),
select 2: Parameter and proceed as described in Parameterizing the indirect trigger.

Information

For subsequent motion blocks due to interruption, the trigger condition is evaluated while the previous motion is still
running by using J271 – J275. J21 Command Mode controls when the triggered subsequent motion block is started. When
0: Abort current command is selected, the subsequent motion block is executed immediately after the trigger condition is
active. When 1: Start when current command has finished is selected, the subsequent motion block is buffered during
activation of the trigger condition, but not executed until the motion block end.

Information

For motion blocks with a final velocity, you can parameterize a special case: a buffered subsequent motion block with
trigger condition. To do so, use a subsequent motion block due to interruption (J271 – J275) with J21 Command Mode = 
1: Start when current command has finished.

When 1: Start when current command has finished is selected, the subsequent motion block is buffered during activation of
the trigger condition, but not executed until the motion block end. This enables a fluid transition to the subsequent motion
block, depending on a trigger condition.
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Parameterizing the indirect trigger

Parameterize the trigger condition for motion block continuation. If you parameterize a subsequent motion block that is to
be triggered at the end of the previous motion block, the condition for continuation must be fulfilled before the set position
is reached.

ü You have selected 2: Parameter for J450[0] Source trigger.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block >
Indirect trigger: Data source.

2. J439[0] Source indirect trigger:
Activate the desired indirect trigger and enter the condition for continuation to subsequent motion block A.

2.1. If a simple parameter is used as the condition for continuation, select the BOOL notation: Coordinate.

2.2. If a certain bit of a simple parameter is used as the condition for continuation, select the bit notation:
Coordinate.Bit.

2.3. If an array or record parameter is used as the condition for continuation, select the array notation:
Coordinate[Element].

2.4. If a certain bit of an array or record parameter is used as the condition for continuation, select the following
notation: Coordinate[Element].Bit.

Information

Using J439, you can specify a parameter, a single bit or an element of an array parameter as the source for the indirect
trigger. Possible sources for indirect triggers include individual bits of the status or control word for control via fieldbus or
signals from additional functions such as motion block duration, comparator or cams.

Information

When using double-axis controllers and axis-specific parameters, make sure that the axis is addressed correctly (axis A:
1stCoordinate; axis B: 2ndCoordinate). They can only access the parameters of their own axis.

Notation Input format Example

BOOL notation Coordinate J439[0] = I86

The subsequent motion block is only triggered if I86 In
reference is fulfilled, i.e. if the axis is referenced.

Bit notation Coordinate.Bit J439[0] = J453.0

You use J452 FSM block duration and the triggering of the
subsequent motion block is to be time-controlled. The
information "Motion block duration is reached" is stored in
bit 0 of J453 FSM end of block duration.

Array notation Coordinate[Element] J439[0] = I64[0]

The subsequent motion block is to be triggered once the
first cam position is reached. The information for the first
cam is stored in array element 0 of I64 Cam result.

Combined notation Coordinate[Element].Bit –

Tab. 4: Indirect trigger: Notations
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5.8.2.4.1.2 Parameterizing the buffered subsequent motion block

In the Subsequent motion block wizard, you can define a buffered subsequent motion block for each motion block. This
means that the subsequent motion block is already loaded while the previous motion block is still being executed.
Continuation therefore takes place automatically at the end of the previous motion block, without a delay and without a
trigger signal.

Information

Depending on the application case, you can either parameterize a regular subsequent motion block or a buffered
subsequent motion block at the end of the previous motion block. The use of a regular subsequent motion block at the end
rules out the simultaneous use of a buffered subsequent motion block for the same motion block, and vice versa. You can
combine subsequent motion blocks through interruption with regular subsequent motion blocks at the end and with
buffered subsequent motion blocks.

Parameterizing the buffered subsequent motion block

Use a buffered subsequent motion block if you are moving the axis in the previous motion block with a set position
(MC_MoveAbsolute, MC_MoveRelative, MC_MoveAdditive) and would like to transition fluidly into the next motion upon
reaching the set position with the final velocity.

ü You have parameterized at least two motion blocks.

ü You are moving the axis in the previous motion block with MC_MoveAbsolute, MC_MoveRelative or
MC_MoveAdditive.

ü You have selected 1: Start when current command has finished for the motion block intended as the subsequent
motion block in J21 Command Mode.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Subsequent motion block.

2. Number:
Use the arrow keys to select the number of the motion block to which you would like to add a buffered subsequent
motion block.

3. J286 Buffered motion block:
Select the motion block that is to follow the motion block selected in Number without a delay or trigger signal.

Information

If you add a buffered subsequent motion block using J286 Buffered motion block, make sure that J281 Next motion block A
at end up to J285 Next motion block E at end is set to -1: Inactive.

Information

For motion blocks with a final velocity, you can parameterize a special case: a buffered subsequent motion block with
trigger condition. To do so, use a subsequent motion block due to interruption (J271 – J275) with J21 Command Mode = 
1: Start when current command has finished.

When 1: Start when current command has finished is selected, the subsequent motion block is buffered during activation of
the trigger condition, but not executed until the motion block end. This enables a fluid transition to the subsequent motion
block, depending on a trigger condition.
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5.8.2.4.2 Testing the motion block linking

Motion block control panel provides all functions that you need to test the motion block linking.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

ü The drive controller is switched on.

ü You have established an online connection to the drive controller.

ü You have parameterized at least one motion block.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block control panel.

2. Click Control panel on and then Enable.

ð The drive is controlled using the active control panel.

3. J311 Motion block selection:
Select the motion block whose linking with the subsequent motion block you would like to check.

4. Test the positions, velocities, accelerations and brakes and optimize your parameterization based on your test results
if necessary.

5. Repeat the tests for each additional motion block for which you have defined subsequent motion blocks.

6. In order to deactivate the control panel, click Control panel off.
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5.8.2.5 Parameterizing the type of motion block

Define how the motion blocks are to be started. Motion block operating mode offers the option to parameterize the direct
start of up to three motion blocks without a controller. If you would like to use a controller, parameterize the start signal by
defining the source for the execute signal and the source for the selection of the motion block to be started.

5.8.2.5.1 Parameterizing the direct motion block type

Motion block operating mode offers the option to parameterize the direct start of up to three motion blocks of your choice
without a controller.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Direct motion
block start: Data source.

2. J80 Activation direct motion block start:
In order to activate the direct motion block start, select 1: Active.

3. J87 Selected direct motion block start 1: 
Enter the number of the motion block that you would like to start directly.

4. J81 Source direct motion block start 1:

4.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

4.2. If you would like to activate the motion block directly, select 2: Parameter J84.

5. J84 Direct motion block start 1:
If you have selected 2: Parameter J84 for J81 and want to start the motion block directly from DriveControlSuite,
select 1: High.

6. Configure the direct start of a second and third motion block in the same way as the first motion block, if necessary.

6.1. If you want to parameterize the direct start for a second motion block, repeat the steps in the same way for
J88, J82 and J85.

6.2. If you want to parameterize the direct start for a third motion block, repeat the steps in the same way for J89,
J83 and J86.

Information

If you have configured the direct start of multiple motion blocks, they are activated with a simultaneous start signal
according to your priority: J83 Source direct motion block start 3 > J82 Source direct motion block start 2 > J81 Source direct
motion block start 1.
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5.8.2.5.2 Parameterizing the execute signal

If you want to use a controller and start the motion block using an execute signal, define the source for the execute signal
and the source for the selection of the motion block that is to be started by the execute signal.

Defining a source for the execute signal

1. Select the Drive Based Synchronous application wizard > Data sources > Application digital signals: Data source.

2. I100 Source execute:
To start a motion block via a controller, select the source for the execute signal.

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 0 of the control word I210 of the application is the source, select 2: Parameter.

Source for motion block selection

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Motion block
selection: Data source.

2. J03 Source motion block selection:
To be able to select a motion block via a controller, select the source for the motion block selection signal.

2.1. If the control word J02 of motion block operating mode acts as the data source, select 1: Parameter J02 and
enter the number of the motion block to be started in the event of an execute signal in J02Reference motion
block.

2.2. If digital inputs act as the source, select 2: Digital inputs and enter the digital inputs (direct or inverted) that
activate a controller or binary switch.

5.8.2.6 Parameterizing the motion block end control unit

The motion block end control unit allows you to monitor the status of up to 5 freely selectable motion blocks, making it
easier for you to keep track of the motion block linking.

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block end control
unit.

2. Activate the desired number of motion blocks to be monitored using the respective option.

ð Parameter J455[0] – [4] can be parameterized according to your selection.

3. J455 Move reference block:
Select the number of the motion block whose status you wish to monitor.

ð The state of the selected reference motion blocks can be observed in J457[0] – [4].

Information

The motion block end control unit indicates that the end of motion block has been reached (J457 = 1: High) as soon as the
motion core has completed the motion command to be executed (I92 = 1: Active) and the actual motion block matches the
reference motion block (J300 = J455).

If J455 is subsequently changed, the motion block chain must first be run through completely before J457 displays the
correct state. If a motion block is executed several times, J457 is reset to 0: Low until the motion command is ended again.
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5.8.2.7 Parameterizing the continue, reset and halt signal

To use the continue function to resume an interrupted motion block, configure the sources of the continue and reset
signals. If you would like to use the motion command MC_Halt to stop a motion block during its run, also add the associated
signal source here.

You can find more information on the continue function, continuable motion commands and reasons for canceling under
Continue function [} 142].

1. Select the Drive Based Synchronous application wizard > Motion block operating mode > Motion block > Operating
mode digital signals: Data source.

2. J917 Source continue: 
To use the continue function to resume interrupted motion commands, select the source for the continue signal.

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control byte J01 of the application acts as the source, select 2: Parameter J01.

ð Bit 2 of the control byte is set as the source.

3. J07 Source reset motion block:
To delete a canceled motion block from the continue memory and enable a different motion block start, enter the
source for the reset signal.

3.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

3.2. If the control word J01 is used as the source for the motion block operating mode, select 2: Parameter J01.

ð Bit 1 of the control word is set as the data source.

4. J06 Source MC_Halt motion block: 
To be able to stop a motion block in general, select the source for the stop signal.

4.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

4.2. If the control word J01 is used as the source for the motion block operating mode, select 2: Parameter J01.

ð Bit 0 of the control word is set as the data source.
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5.8.3 Parameterizing command operating mode
The following graphic shows the signal flows of the command operating mode. The elements shown in a lighter shade are
optional.

Controller

Motion
command

Motion
core

Continue
function

DI DI

Controller

AI

Controller

Controller

Start
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variables

Motor

Start signal

Override

Alternative
sources

Fig. 4: Command operating mode: signal flows

In command operating mode, motion profiles are sent from a controller to the drive controller in the form of motion tasks.
A motion task includes a PLCopen-compliant motion command which defines the basic motion method of the axis. The
associated motion variables supply specifications on velocity, acceleration, deceleration and jerk, from which the motion
core of the drive controller calculates the motion profile.

The controller coordinates the time progression and selects the motion tasks for the drive controller that the positioning,
velocity and torque/force commands process and run. In the controller, you define the motion tasks. In the DS6, you
parameterize the signal sources from which the drive controller receives the motion tasks from the controller.

In command operating mode, drive controllers are either activated using a fieldbus or by a mixed operation of a fieldbus
and terminals.

Information

The motion variables available for this operating mode that you configure in the software depend on your application case
as well as on additional project-specific factors such as the use of a controller or the type of data transmission (fieldbus,
terminals).
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Proceed as follows ...

§ Activate command operating mode.

§ Optional: Limit torque/force using the operating mode.

§ Parameterize the command-specific motion variables.

§ Define the source for the start signal.

§ Optional: Define the source for the continue signal.

5.8.3.1 Activating command operating mode

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard.

3. Operating modes area:
Activate the Command operating mode option.

ð The corresponding wizards are displayed.

5.8.3.2 Limiting the torque/force using the operating mode

Basic torque/force limiting using the mechanical system takes place in the project configuration of the axis model. As an
option, you can parameterize an additional torque/force limit via the operating mode.

1. Select the Drive Based Synchronous application wizard > Data sources > Torque/force limit: Data source.

2. C132 Source maximum positiv T/F, C133 Source maximum negative T/F:
Select the source for the torque/force limit.

2.1. If the limiting values are transmitted over a fieldbus, select 4: Parameter C232 or 4: Parameter C233.

3. If the limiting values are transmitted over a fieldbus, select Drive Based Synchronous application > Command
operating mode wizard.

4. J47 Maximum positive torque/force, J48 Maximum negative torque/force:
Enter the maximum permitted positive and negative values for torque/force.

Information

The mechanical torque/force limit is executed using the axis model (limit: C03 and C05). Additional limiting through the
operating mode is optional and applies to the maximum permitted values for torque/force that you defined in the axis
model (reference values: C03, C05).
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5.8.3.3 Parameterizing command-specific motion variables

The parameters for the acceleration, deceleration and jerk motion variables are not included as standard in the process
data mapping. You can either store the values for the motion variables permanently on the drive controller or add the
corresponding parameters to the process data mapping in order to receive the values from the controller.

Information

Before you start parameterizing the operating mode-specific motion variables, parameterize the general motion variables
and signal sources. If you obtain set values for velocity, velocity override or torque/force for your drive project from
external sources, proceed as described in the chapter General motion variables and signal sources [} 49].

5.8.3.3.1 Storing motion variables: Drive controller

If you want to store the specifications for acceleration, deceleration and jerk permanently on the drive controller, check the
default values in the Command operating mode wizard and, if necessary, adjust them to your drive project.

ü You have activated command operating mode.

ü Parameters J44, J45 and J46 are not part of the process data mapping.

1. Select the Drive Based Synchronous application wizard > Command operating mode.

2. J44 Acceleration, J45 Deceleration, J46 Jerk:
Define the set values for acceleration, deceleration and jerk.

ð The specifications for acceleration, deceleration and jerk are permanently stored on the drive controller.

Information

The parameters in the Command operating mode wizard are written by the controller once there is an online connection
between the drive controller and controller and provided that the parameters are part of the process data mapping. In this
state, you can read off the values in the parameters that the drive controller receives from the controller. Using parameter
J41 Motion-ID, you can identify the ongoing motion task in order to assign the status bit correctly.
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5.8.3.3.2 Storing motion variables: Process data mapping

If you want to specify the settings for acceleration, deceleration and jerk via a controller, add the required parameters to
both the receive process data of the drive controller and the transmit process data of the controller.

Information

When using double-axis controllers and axis-specific parameters, make sure that the axis is addressed correctly (axis A:
1stCoordinate; axis B: 2ndCoordinate). They can only access the parameters of their own axis.

EtherCAT: Supplementing motion variables in PDO mapping

If you want to specify values for motion variables using a controller, supplement the desired parameters in the receive
process data of the drive controller.

ü You have activated command operating mode.

1. Select the EtherCAT wizard > Received process data RxPDO.

2. Coordinate column:
Enter the coordinate of the parameter that you want to apply to the process data mapping in the Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.

2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

ð The parameter is applied to the receive process data of the drive controller.
In the Name, Data type and Length columns, your information about the parameters is displayed.

3. Add your changes to the process data mapping also to the transmit process data of the controller.

PROFINET: Supplementing motion variables in PZD mapping

If you want to specify values for motion variables using a controller, supplement the desired parameters in the receive
process data of the drive controller.

ü You have activated command operating mode.

1. Select the PROFINET wizard > Received process data RxPZD.

2. Coordinate column:
Enter the coordinate of the parameter that you want to apply to the process data mapping in the Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.

2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

ð The parameter is applied to the receive process data of the drive controller.
In the Name, Data type and Length columns, your information about the parameters is displayed.

3. Add your changes to the process data mapping also to the transmit process data of the controller.
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5.8.3.4 Parameterizing the start signal

Define the source for the execute signal in order to start a motion command selected in J40 in command operating mode.

1. Select the Drive Based Synchronous application > Data sources > Application digital signals: Data source.

2. I100 Source execute:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control word I210 of the application acts as the source, select 2: Parameter.

ð Bit 0 of the control word is set as the data source.

5.8.3.5 Parameterizing the continue signal

To use the continue function to resume an interrupted movement command, configure the source of the continue signal. If
you do not use the continue function, select a new command using J40 and start it using the start signal (execute).

You can find more information on the continue function, continuable motion commands and reasons for canceling under
Continue function [} 142].

1. Select the Drive Based Synchronous application > Command operating mode > Operating mode digital signals: Data
source.

2. J38 Source continue:
To use the continue function to resume interrupted motion commands, select the source for the continue signal.

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control byte J37 for the command operating mode acts as the source, select 2: Parameter.

ð Bit 0 of the control byte is set as the source.
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6 More on Drive Based Synchronous?
The following chapters summarize the important terms, modules and relationships concerning Drive Based Synchronous.

6.1 Drive Based Synchronous – Concept
Applications such as Drive Based Synchronous, which calculate and adjust the motions in the drive itself, are referred to as
drive-based systems. They are either networked via a fieldbus or obtain signals and set values using analog and digital
hardware inputs.

The Drive Based Synchronous application provides you with a standard set of motion commands based on PLCopen, which
is supplemented by your own motion commands and thus offers flexible drive-based motion control for the position,
velocity and torque/force control types.

The motion commands are combined into corresponding operating modes for different applications. Depending on the
selected operating mode, the motion variables required for parameterizing individual motion profiles, such as set or limit
values, are recorded.

In addition, the Drive Based Synchronous application provides you with various additional functions for different
applications, such as jerk limitation, motion block linking, cam control unit or PID controller.

Various technological functions are available for the synchronous operation of multiple axes (multi-axis movements). As a
rule, a master specifies set values which the coupled slave axes follow according to the specified proportional ratio. For
example, a real axis, master encoder or virtual master can serve as the master.

Based on all parameterized data, the motion core finally calculates an individual motion profile. Specified set values are
transmitted to the control cascade, which in turn activates the motor.

Additional wizards such as control panels or jog mode help with commissioning and the configuration test or are designed
for emergency operation.

The following graphic shows the components and configuration steps for the Drive Based Synchronous application. The
elements shown in a lighter shade are optional.
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Fig. 5: Components and configuration steps

6.1.1 Operating modes
The operating modes of the Drive Based Synchronous application involve command sets bundled by application for
configuring individual motion profiles for production operation.

The drive functions of these operating modes span from simple functions like position, velocity and torque/force control
types to technology functions for individual axis applications to a synchronous operation of multi-axis systems.

Thanks to flexible, user-defined adjustment options for the operating modes, the Drive Based Synchronous application
offers a compact – yet extremely variable – scope of functions that is suitable for a wide range of application cases in drive
technology. After selecting the suitable operating mode for the respective application case, users concentrate just on
parameterizing the most important sequences for their application.

Note that a drive controller can only process one operating mode per axis.
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6.1.1.1 Motion block

In motion block operating mode, motion properties are predefined in the form of motion blocks. Special linking options
allow for complete motion sequences to be set up that make it possible to execute sequences of motions quickly –
regardless of whether an external controller is connected or the motion sequences are executed through digital signals.

Typical application examples are small machine automations or machine modules with predefined motion sequences.

Motion block linking

You can define one or more possible subsequent motion blocks for each motion block. Continuation to the subsequent
motion block either happens automatically at the end of the motion block or is caused by a trigger. The trigger can either be
a direct trigger signal or a trigger condition that is configurable in the software (indirect trigger).

For subsequent motion blocks with triggers, a distinction is made between subsequent motion blocks that are triggered at
the end of the previous motion block and subsequent motion blocks that interrupt the previous motion block when an
interrupt signal is triggered. The continuation can be executed by a direct or indirect trigger in either case.

Subsequent motion blocks at the end of a motion block are triggered as soon as the set value of a finite motion command is
reached and the trigger is active. For subsequent motion blocks due to interruption, a finite or endless motion is
interrupted and continued in the subsequent motion block as soon as the trigger is active. For example, the ongoing motion
can be interrupted when a sensor or light barrier is triggered and the axis stopped.

Buffered subsequent motion blocks are parameterized without triggers and are intended for the case where the axis is
moved to a set position in the previous motion block that is reached with the final velocity. In order to continue the motion
fluidly and start the next motion command without a delay or standstill, the subsequent motion block is loaded in advance
(buffered) while the previous motion block is still being executed. The continuation happens automatically at the end of the
previous motions block.

6.1.1.2 Command

Command operating mode enables a drive controller to run parameterizable motions. In this process, a range of motion
commands are processed that correspond to the behavior of the motion control blocks of the PLCopen standard.

A controller coordinates the time sequences by selecting motion commands based on PLCopen, such as MC_MoveAbsolute
(move to absolute set position) or MC_MoveRelative (move relative to actual position).

Parameters such as set position, velocity or torque limit can be defined individually.

Typical application examples are individual axis movements that are communicated by a controller (PLC) to the drive
controller.

6.1.2 Jog mode
For commissioning, emergency operation and maintenance or repair work, the manufacturer-specific jog mode (manual
movement) is available. Using jog mode, you can move the drive independently of the controller, for example.

You can use jog mode either through the jog control panel or a controller that applies the manual movement.
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6.1.3 Control panels
The control panels are special wizards in DriveControlSuite, which you can use to take control of the axis. With the help of
the control panels, you can manually release and move an axis even if the drive controller has no operating unit or is
difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical axis model or the
parameterization of your application in the respective operating mode before you switch to normal operation.

The following control panels are available:

§ Jog control panel is used to check the projected axis model in jog mode.

§ Control panel motion provides you with a standard set of motion commands based on PLCopen. Via the control panel,
independent of the application and fieldbus interface, you can parameterize a motion profile directly for the motion
core of the axis in order to check the basic functions of the drive controller.

§ Motion block control panel is used to check the parameterized motion block operating mode and provides you with all
the functions you need to test the parameterization of individual motion blocks or motion block linking.

§ Jog control panel: Virtual master enables you to move the virtual master in jog mode to test synchronous operation.

§ Control panel motion: Virtual master enables you to move the virtual master via PLCopen compliant motion commands
to test synchronous operation.

Because control panels override normal operation, they can be activated only with a deactivated enable signal and should
be operated by experienced users only.

6.1.4 Motion core
Based on the projected and parameterized data, the motion core calculates a motion profile and associated detail
movements as a basis for the drive controller as well as mandatory set values for the control cascade.

6.1.5 Data sources
The signals for controlling the drive controller, i.e. control signals for the start of motion, motion limits or set value
specifications, can be obtained from various external sources.

A fieldbus is usually acts as the signal source, but digital hardware inputs, or even mixed operation of the above-listed
sources, can also be used to control the drive controller.

Values that are obtained from external data sources are usually adapted to the stored reference values automatically, i.e.
calibrated and calculated with scaling.
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6.1.6 Additional functions
Each of the available operating modes can be expanded by drive-based additional functions. For example, these offer
convenient monitoring of process variables such as position, velocity or torque/force (cams, comparators) or control of
external process variables (PID controller).

6.1.6.1 Additional counter function

The additional counter function in Drive Based type applications provides you with up to 4 independent counters with
which you can implement smaller automation tasks directly in the drive controller, such as direct or indirect control of the
digital outputs.

Function

For each counter, you define a comparison value, a digital signal for increasing the counter reading and a digital signal for
resetting the counter reading (comparison value: N41; increase source: N43; reset source: N46). With each rising edge of
the counter signal, the counter reading is increased by 1 until the comparison value is reached (counter reading: N44).
When the comparison value is reached, a status signal is issued and further counter signals are ignored until the counter
reading is reset or the comparison value is increased (status: N42).

Signals

Counter reading

3 = Comparison value
2
1
0

Reset

Counting

t

t

t

Fig. 6: Additional counter function: Example

The digital inputs of the drive controller (direct or inverted), parameters with the BOOL data type or individual bits of
parameters with the BYTE, WORD or DWORD data type (example bit addressing: E49.4 for Switch on inhibit reason = STO)
can serve as the source for the signals for increasing and resetting the counter status. The reset signal has priority and is
executed immediately; as long as it is active, the counter reading remains at 0 and rising edges to increase the counter
reading are ignored.
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6.1.6.1.1 Parameterizing counters

To parameterize the additional counter function, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions.

3. Activate the Counter option.

ð The additional function is activated and the associated wizards and parameters are displayed.

4. Select the Drive Based Synchronous application wizard > Additional functions > Counters.

5. Number:
Select the desired counter and activate it using the corresponding option.

ð The associated parameters are displayed.

6. N41 Counter comparison value:
Define the comparison value.

7. N43 Source counter:
Select the source for the signal that increases the counter reading by 1 until the comparison value is reached.

7.1. If a parameter is the source, select 2: Parameter.

7.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

8. N45 Counter indirect reading:
If a parameter is used as the source for increasing the counter, define the desired coordinate, if necessary with bit
addressing.

9. N46 Source reset counter reading:
Select the source for the signal that resets the counter reading to 0.

9.1. If a parameter is the source, select 2: Parameter.

9.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

10. N47 Reset counter reading via parameter:
If a parameter is used as the source for resetting the counter, define the desired coordinate, if necessary with bit
addressing.
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6.1.6.1.2 Parameterizing counters: Examples

For example, you can use the additional counter function to control the digital outputs directly or indirectly (using the
additional INT32 comparator function) by reaching the comparison value.

In motion block operating mode, the additional counter function offers you options for automating motion block
continuation, e.g. for repeating a motion block as often as required or interrupting a motion block after a certain number of
events.

You can find more information on parameterizing motion blocks, subsequent motion blocks and triggers under
Parameterizing motion block operating mode [} 53].

Controlling a digital output directly

To control a digital output directly via the counter, you can use the status of the counter as a source.

1. Activate the additional counter function.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

4. Select the status of the counter as the source for the desired digital output (e.g. DO1: F61 = N42).

ð The digital output is controlled directly via the status of the counter.

Controlling a digital output indirectly (INT32 comparator)

To indirectly control a digital output, you can use the additional counter and INT32 comparator functions in combination
with each other. If you use the INT32 comparator to check whether the current counter reading fulfills a certain condition,
you can control a digital output depending on the result of the comparator.

1. Activate the additional counter and comparator functions.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

4. Select the INT32 comparators wizard.

5. Parameterize the INT32 comparator according to your application case.

5.1. C78 Source INT32 comparator:
Select the counter reading N44 as the source for the INT32 comparator.

6. Select the result of the INT32 comparator as the source for the desired digital output (e.g. DO1: F61 = C83).

ð The digital output is controlled indirectly via the counter reading.
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Interrupting a motion block

To interrupt a motion block after a certain number of events, parameterize a motion block with an endless motion
command, as well as a subsequent motion block using an interrupt with a motion command to stop an ongoing motion. The
subsequent motion block is triggered by an indirect trigger, using the status of the counter as the source.

1. Activate the additional counter function.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

4. Select the Motion block wizard.

5. Parameterize at least motion block 0 and motion block 1 according to your application.

5.1. J11[0] Command:
Select for motion block 0 an endless motion command (e.g.8: MC_MoveSpeed).

5.2. J11[1] Command:
Select a motion command to stop for motion block 1 (e.g. 5: MC_Stop).

6. For motion block 0, parameterize the motion block start (e.g. J80 = 1: Active; J81 = 3: DI1; J87 = 0).

7. Select the Subsequent motion block wizard.

8. J271[0] Next motion block A by interrupt:
Select motion block 1 as the subsequent motion block using interrupt for motion block 0.

9. Select the Trigger: Data source wizard.

10. J450[0] Source trigger:
To parameterize the status of the counter as an indirect trigger for the subsequent motion block, select 2: Parameter.

11. Select the Indirect trigger: Data source wizard.

12. J439[0] Source indirect trigger:
Activate the indirect trigger and define the status of the counter N42 as the source.

ð As soon as the counter has reached the comparison value, motion block 0 (8: MC_MoveSpeed) is interrupted by
motion block 1 (5: MC_Stop) as a subsequent motion block by interrupt.
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Repeating a motion block

To execute a motion block for a certain number of repetitions, parameterize a motion block with a finite motion command
and a wait time at the end, as well as a subsequent motion block at the end with the 0: MC_DoNothing motion command.
The subsequent motion block is triggered by an indirect trigger using the status of the counter as the source as soon as the
desired number of repetitions has been reached.

Information

The status byte in the motion block operating mode indicates a motion block as ended if the motion core has successfully
completed the motion command to be executed and if there is either no subsequent motion block (single motion block or
end of the motion block chain) or if a wait time at the end has been parameterized for a motion block with a subsequent
motion block and the subsequent motion block has not been started yet x(status byte: J302, bit 3; motion core: I92; wait
time: J24).

If bit 3 of the status byte J302 is used as the source for the additional counter function in motion block operating mode, the
wait time at the end should be at least twice the cycle time (cycle time: A150).

1. Activate the additional counter function.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

3.1. N41 Counter comparison value:
Define the desired number of motion block repetitions as the comparison value.

3.2. N43 Source counter, N45 Counter indirect reading:
To count the number of times a motion block has been completed using the status byte of motion block
operating mode, select N43 = 2: Parameter and N45 = J302.3.

4. Select the Motion block wizard.

5. Parameterize at least motion block 0 and motion block 1 according to your application.

5.1. J11[0] Command:
Select a finite motion command for motion block 0 (e.g. 2: MC_MoveRelative).

5.2. J24 Waiting time at the end:
Define the desired wait time at the end for motion block 0.

5.3. J11[1] Command:
Select motion command 0: MC_DoNothing for motion block 1.

6. For motion block 0, parameterize the motion block start (e.g. J80 = 1: Active; J81 = 3: DI1; J87 = 0).

7. Select the Subsequent motion block wizard.

8. To be able to both repeat and interrupt motion block 0, parameterize two subsequent motion blocks for motion block
0.

8.1. J281[0] Next motion block A at end:
Select motion block 1 as the subsequent motion block at the end of motion block 0 (0: MC_DoNothing).

8.2. J282[0] Next motion block B at end:
Select motion block 0 as the subsequent motion block at the end of motion block 0 (2: MC_MoveRelative).

ð Subsequent motion block A is executed with higher priority than subsequent motion block B if both subsequent
motion blocks are triggered simultaneously.

9. Select the Trigger: Data source wizard.
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10. J450[0] Source trigger:
To parameterize the status of the counter as an indirect trigger for subsequent motion block A, select 2: Parameter.

11. J450[1] Source trigger:
To automatically repeat motion block 0, select 1: High as the trigger for subsequent motion block B.

ð Subsequent motion block B is executed until subsequent motion block A is triggered (priority: J281 > J282).

12. Select the Indirect trigger: Data source wizard.

13. J439[0] Source indirect trigger:
Activate the indirect trigger and parameterize the status of the counter N42 as the source.

ð As soon as the counter has reached the desired number of repetitions, motion block 1 (0: MC_DoNothing) is executed
at the end of motion block 0 (2: MC_MoveRelative) due to its higher priority.



STOBER 6 | More on Drive Based Synchronous?
10

/2
02

5 
| 

ID
 4

43
05

9.
04

85

6.1.6.2 Additional motor potentiometer function

In Drive Based Synchronous type applications, the additional motor potentiometer (MOP) function provides you with the
option of adjusting an electromechanical potentiometer, such as for set value specification or for indirect control of the
digital outputs.

Function

The motor potentiometer can be adjusted continuously via digital up and down signals, for example for specifying set
values for axis movements via the output value (output value: G373). The output value can be limited by a maximum
positive and a maximum negative value (limit: G362, G363; limit value reached: G374). Either the digital inputs of the drive
controller or the graphical programming can serve as the source for the up and down signals (source: G364, G365). The
initialization signal has priority over the up and down signals and is executed immediately; the initialization value is freely
definable (source: G369; value: G366).
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Fig. 7: Motor potentiometer: Linear and stepwise calculation

You can use the operating mode of the motor potentiometer to influence both the calculation of the output value and the
storage behavior (operating mode: G368). The output value is calculated either linearly or in steps and can be saved either
with an active enable signal, prior to the next restart of the drive controller or in non-volatile memory. The parameterized
ramp (ramp: G361) applies to both the linear and stepwise calculations. With a linear calculation, the output value is
changed for the duration of the incoming up or down signal. With a stepwise calculation, the output value is changed by the
parameterized increment at signal input (increment: G367). If another up or down signal is received while the set value has
not yet been reached, it is adjusted by the corresponding increment. If the up and down signals are active at the same time,
the output value remains unchanged in both operating modes.
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6.1.6.2.1 Parameterizing motor potentiometers

To parameterize the additional motor potentiometer function, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions.

3. Activate the Motor potentiometer option.

ð The additional function is activated and the associated wizards and parameters are displayed.

4. Select the Drive Based Synchronous application wizard > Additional functions > Motor potentiometer.

5. G361 Motor potentiometer ramp:
Define the ramp for calculating the output value.

6. G362 Motor potentiometer positive maximum value, G363 Motor potentiometer negative maximum value:
Define the maximum permissible positive and negative output values of the motor potentiometer.

7. G364 Source motor potentiometer up, G365 Source motor potentiometer down:
Select the sources for the up and down signals of the motor potentiometer.

7.1. If the graphical programming is used as the source, select 2: Parameter.

7.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

8. G368 Motor potentiometer operating mode:
Select the desired operating mode for the motor potentiometer.

8.1. To calculate the output value of the motor potentiometer linearly, select 0: Linear, 2: Linear (remanent) or 
4: Linear (enable-dependent), depending on the desired storage behavior.

8.2. To calculate the output value of the motor potentiometer in steps, select 1: Step-by-step, 3: Step-by-step
(remanent) or 5: Step-by-step (enable-dependent), depending on the desired storage behavior.

9. G367 Motor potentiometer increment:
If you calculate the output value of the motor potentiometer in steps, define the desired increment.

10. G366 Motor potentiometer initialization value:
Optionally define the desired initialization value.

11. G369 Source motor potentiometer initialization:
Select the source for the initialization signal of the motor potentiometer.
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6.1.6.2.2 Parameterizing motor potentiometers: Examples

For example, you can use the additional motor potentiometer function to specify set values for the velocity, velocity
override or torque/force and thus control the axis directly in local operation, e.g. during commissioning, if the controller
fails or if the machine has no controller at all. Using the motor potentiometer, you can also control the analog outputs
directly or the digital outputs indirectly (using the additional REAL32 comparator function).

Controlling a digital output indirectly (REAL32 comparator)

To indirectly control a digital output, you can use the additional motor potentiometer and INT32 comparator functions in
combination with each other. If you use the REAL32 comparator to check whether the output value of the motor
potentiometer fulfills a certain condition, you can control a digital output depending on the result of the comparator.

1. Activate the additional motor potentiometer and REAL32 comparator functions.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the REAL32 comparators wizard.

5. Parameterize the REAL32 comparator according to your application case.

5.1. C65 Source REAL32 comparator:
Select the output value of the motor potentiometer G373 as the source for the REAL32 comparator.

6. Select the result of the REAL32 comparator as the source for the desired digital output (e.g. DO1: F61 = C75).

ð The digital output is controlled indirectly via the motor potentiometer.
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Specifying a set velocity (external velocity)

To specify a set velocity via the motor potentiometer, select its output value as the source for the external velocity and use
this as the set value source for the motion command.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the External velocity: Data source wizard.

5. G461 Source external velocity: 
Select 5: Indirect read parameter G811.

6. G811 Indirect read external velocity:
Select the output value of the motor potentiometer G373 as the source for the external velocity.

ð The output value of the motor potentiometer serves as the source for the external velocity.

ð The external velocity can be provided as a set value specification by accessing parameter G462.

7. For the motion block operating mode, parameterize the motion command and set value source via parameters J11
and J30.

7.1. J11 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. J30 Source velocity:
Select 1: Parameter G462 as the source for the external velocity.

8. For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J52.

8.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

8.2. J52 Source velocity 1:
Select 1: Parameter G462 as the source for the external velocity.

ð The output value of the motor potentiometer serves as the set value specification; the conversion to a set velocity is
carried out using maximum permissible speed I10.
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Specifying a set velocity (external additional velocity)

To additionally regulate the set velocity via the motor potentiometer, select its output value as the source for the external
additional velocity and use this as the set value source for the motion command.

ü You are using command operating mode or velocity, torque/force operating mode.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the External additional velocity: Data source wizard.

5. G464 Source external additional velocity: 
Select 5: Indirect read parameter G811.

6. G812 Indirect read additional external velocity:
Select the output value of the motor potentiometer G373 as the source for the external additional velocity.

ð The output value of the motor potentiometer serves as the source for the external additional velocity.

ð The external velocity can be provided as a set value specification by accessing parameter G465.

7. For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J54.

7.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. J54 Source velocity 2:
Select 1: Parameter G465 as the source for the external additional velocity.

ð The output value of the motor potentiometer serves as the set value specification; the conversion to a set velocity is
carried out using maximum permissible speed I10.
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Specifying the velocity override

To specify a velocity override via the motor potentiometer, select its output value as the set value source and apply the
velocity override to the motion command.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the Velocity override: Data source wizard.

5. G467 Source velocity override: 
Select 5: Indirect read parameter G813.

6. G813 Indirect read velocity override:
Select the output value of the motor potentiometer G373 as the source for the velocity override.

ð The output value of the motor potentiometer serves as the source for the velocity override.

ð The velocity override can be provided as a set value specification by accessing parameter G468.

7. For the motion block operating mode, parameterize the motion command and set value source via parameters J11
and J28.

7.1. J11 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. J28 Velocity override enable:
To apply the velocity override to the desired motion block, select 1: Active.

8. For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J51.

8.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

8.2. J51 Source velocity override:
Select 1: Parameter G468 as the source for the velocity override.

ð The output value of the motor potentiometer is used as the set value specification for the velocity override.
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Specifying the set torque/set force

To specify a set torque/force via the motor potentiometer, select its output value as the set value source for the motion
command.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the Set torque/force, velocity bracketing: Data source wizard.

5. G470 Source torque/force reference: 
Select 5: Indirect read parameter G814.

6. G814 Indirect read torque/force reference:
Select the output value of the motor potentiometer G373 as the source for the set torque/force.

ð The output value of the motor potentiometer serves as the source for the set torque/force.

ð The set torque/force can be provided as a set value specification by accessing parameter G471.

7. For the motion block operating mode, parameterize the motion command and set value source via parameters J11
and J32.

7.1. J11 Command:
Select the 9: MC_TorqueControl motion command.

7.2. J32 Source reference torque/force:
Select 1: Parameter G471 as the source for the set torque/force.

8. For the command operating mode, parameterize the motion command and set value source via parameter J40.

8.1. J40 Command:
Select the 9: MC_TorqueControl motion command.

ð The parameterized set value source is applied automatically; no further settings are necessary.

ð The output value of the motor potentiometer serves as the set value specification for the set torque/force.
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6.1.6.3 Additional phasing function

In Drive Based Synchronous applications, the additional phasing function allows you to make corrections to the master
position while the slave axis is coupled to the master. For example, the additional phasing function can be used if position-
based coupling of the slave axis via 14: MC_GearInPosition is not possible or to correct the master value of slave axes if
slipping occurs in the master.

Function

Phasing takes place within the slave axis. The slave axis receives the master position according to the selected master value
source (source: G27). In order to influence the position of the slave axis, a phase shift to the received master position is
specified by the set position of the phasing (set position: G223). The phase shift is added to the received master position
(total master position: G80).

The slave axis attempts to compensate for the phase shift by accelerating or decelerating. The compensation movement
has its own motion profile, which can be limited in terms of velocity, acceleration and jerk as well as permitted direction of
motion (motion profile: G224 – G227; limitation: G70 – G73). The compensation movement can therefore be executed
while the slave axis is coupled to the master.

Phasing can be started either via the digital inputs of the drive controller or via fieldbus (source: G230). The phase shift is
maintained until a new set position is specified by another phasing command. The phase shift can be executed with an
absolute set position or a set position relative to the existing phase shift, i.e. to the actual position of the phasing at the
start of the command (motion command: G234; actual position: G214).

t
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v

t
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Execute

Done

Fig. 8: Additional phasing function: Example

The example shows a phasing compensation movement with motion command G234 = 2: MC_MoveRelative. When the
Execute signal is triggered, the slave axis accelerates or decelerates according to the parameterized motion profile in order
to compensate for the phase shift specified via G223. The difference between the master position received (source: G27)
and the master position G80 of the slave axis used for motion commands corresponds to G214.

To ensure that the axis interrupts the active phasing motion command during the compensation movement, a separate
quick stop can be parameterized for the phasing (quick stop: G74, G76, G216).

A preset function is available for phasing (preset: G78, G79, G240) in order to set the slave axis to a specific position
immediately and without a motion profile when decoupled.
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Application example

You are using a controller and operating the Drive Based Synchronous application in command operating mode. The master
position is measured using a measuring wheel that is in frictional contact with a material web, i.e. a master encoder is
acting as the master value source for the slave axes. There are print marks at regular intervals on the material web, e.g.
plastic film, which can be measured using a sensor. If slipping occurs and the measuring wheel briefly loses frictional
contact with the material web, the controller can detect this using the print marks and compensate for it with the help of
phasing.

6.1.6.3.1 Parameterizing phasing

For phasing, parameterize the limiting values and the source for the Execute signal as described below. The
parameterization of the quick stop and preset function is optional.

Information

To be able to control the additional phasing function via fieldbus, expand the process data mapping using the respective
wizard (EtherCAT: Received process data RxPDO; PROFINET: Received process data RxPZD).

An overview of the phasing parameters that can be written by the controller via fieldbus is provided by the Command
operating mode: Phasing wizard. Add the required parameters to both the receive process data of the drive controller and
the transmit process data of the controller (motion command: G234; set value specifications: G223 – G227; control word:
G10).

Parameterizing phasing

Parameterize the additional phasing function as described below.

ü You have completed the parameterization of synchronous operation.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Phasing > Limit: Phasing.

3. G73 Phasing permitted direction:
If you selected 1: Endless for G30 when configuring synchronous operation, define the permitted direction of motion
for phasing.

3.1. If motions in both directions are permitted, select 0: Positive and negative.

3.2. If motions are only permitted in one direction, select 1: Positive or 2: Negative accordingly.

4. G70 Phasing maximum velocity:
Define the maximum permitted velocity for phasing.

5. G71 Phasing maximum acceleration:
Define the maximum permitted acceleration for phasing.

6. G72 Phasing maximum jerk:
Define the maximum permitted jerk for phasing.

7. Select the Drive Based Synchronous application wizard > Synchronous operation > Master digital signals: Data source.

8. G230 Source phasing execute:
Select the source for the digital signal that is used to start a motion command for phasing.

8.1. If a control unit is used as the source, select 2: Parameter.

8.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.
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Phasing: Parameterizing a quick stop

To interrupt an active phasing motion command with a quick stop, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Phasing.

3. G216 Phasing quick stop additional cause:
Select the device state of the drive controller that is to be an additional cause for triggering a quick stop during
phasing.

3.1. To trigger a quick stop when the axis has a fault, select 1: Error.

3.2. To trigger a quick stop when the axis is not enabled, select 2: Enable.

3.3. To trigger a quick stop when the axis is not enabled or has a fault, select 3: Enable or error.

4. G76 Phasing quick stop additional cause axis selection:
If you are using a double-axis controller, select the axis whose device state is to be taken into account for triggering a
quick stop.

4.1. If the device state of axis A is to be taken into account, select 0: Axis A.

4.2. If the device state of axis B is to be taken into account, select 1: Axis B.

4.3. If the device state of both axes is to be taken into account, select 2: Axis A and B.

5. Select the Drive Based Synchronous application wizard > Additional functions > Phasing > Limit: Phasing.

6. G74 Phasing quick stop deceleration:
Define the delay for the quick stop of the phasing.

Phasing: Parameterizing a preset

To use the phasing preset function, proceed as described below.

WARNING!

Injury to persons and material damage due to slave axis movement!

By activating this function, the master value changes immediately without a motion profile. As a result, coupled slave axes
immediately follow the movement of the master.

▪ Only execute this function if there are no slave axes coupled with the master.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Drive Based Synchronous application wizard > Additional functions > Phasing.

3. G78 Phasing preset position:
Define the set position for the phasing preset.

4. Select the Drive Based Synchronous application wizard > Synchronous operation > Master digital signals: Data source.

5. G240 Source phasing preset:
Select the source for the digital signal that is used to set the axis to the preset phasing position immediately and
without a motion profile.



STOBER 6 | More on Drive Based Synchronous?
10

/2
02

5 
| 

ID
 4

43
05

9.
04

95

6.2 Synchronous operation – Concept
In DriveControlSuite, you have various options for parameterizing synchronous operation, which differ in terms of the
master value source and number of axes involved.

For example, you can use a virtual master as a master value source and provide the master value via the master axis model
to optimize the synchronism of multiple axes (example: smooth motion of a platform). Using a master encoder as a master
value source enables you to synchronize the motion of one or more axes with an upstream machine (example:
synchronizing conveyor belts). Using the actual position of the master axis as a master value allows you to synchronize slave
axes to a main axis.

6.2.1 Model 1: Virtual master or master encoder, multiple slave axes

ME

VM

Motor axis
model

Motor axis
model

Motor Motor

Master
axis model

Slave axis Slave axis

Master

or

Fig. 9: Synchronous operation: Model 1

In this model, a virtual master or master encoder acts as the master value source. For double-axis controllers, both axes
follow the master value that is provided internally by the global master axis model.

This model for the configuration of synchronous operation allows you to synchronize the motion of multiple axes to a
common master value of a virtual master or to the master encoder of an upstream machine, for example.
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6.2.2 Model 2: Master encoder, individual slave axis
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Fig. 10: Synchronous operation: Model 2

In this model, a master encoder acts as the master value source. An individual axis follows the master value that is provided
by an internal device master axis model. There is no need to parameterize additional slave axes.

This model for the configuration of synchronous operation allows you to synchronize the motion of a single axis to the
master encoder of an upstream machine, for example.

Information

If you are using a double-axis controller with two projected axes, you can operate one axis in the Drive Based synchronous
application and another axis in the Drive Based application. This enables you to use the axes independently of each other.
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6.2.3 Model 3: Master axis, one or more slave axes

MotorMotor
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Master axis Slave axis

Master

Fig. 11: Synchronous operation: Model 3

In this model, the actual position of the master axis acts as the master value. For double-axis controllers, axis B follows the
master value that axis A provides internally via the global master axis model.

This model for the configuration of synchronous operation allows you to synchronize slave axes to the actual position of the
master axis, for example.
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6.3 Axis model
With the help of the axis model, you map the real mechanical environment of your drive project in DriveControlSuite by
parameterizing the axis type and the arrangement of existing encoders. The parameterization of the axis model is required
for the smooth operation and easy diagnosis of your drive train.

With I05 Type of axis, you select a rotational or a translational axis model and define whether the scaling of the axis is done
using either predefined or individually configured units of measure. With I00 Position range, you parameterize either an
endless (modulo) or a limited travel range. You parameterize the encoder arrangement by using B26 Motor encoder and
I02 Position encoder.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side motion variables
where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and jerk in the data type REAL32 (floating-
point number, 32 bits). Position values are processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors
and enable precise movements.

Abbreviation Meaning

LinM Linear Motor

M Motor

MEnc Motor Encoder

PEnc Position Encoder

Rotational axis models

The following figures each show a rotational axis model consisting of a motor, a gearbox and a rotary table (endless
rotational) or a pointer (limited rotational). Rotational axis models support rotational motor encoders as well as rotational
position encoders.

n
n

1

2

MEnc Gear PEnc

M

Fig. 12: Endless-rotational motion: Rotary table

M

MEnc PEncGear

n
n

1

2

Fig. 13: Limited-rotational motion: Pointer
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Translational axis models

The following figures each show a translational axis model consisting of a motor, gearbox, feed and conveyor belt (endless
translational) or tool slide (limited translational). Translational axis models support rotational motor encoders as well as
rotational or translational position encoders.

MEnc

n
n

1

2

Gear PEnc Feed

M

PEnc

n
x

Fig. 14: Endless translational motion: Conveyor belt

M

MEnc Gear

n
n

1

2

PEnc Feed

PEnc

n
x

Fig. 15: Limited translational motion: Tool slide

Translational axis model: Linear motor

The following figure shows a limited translation axis model using the example of a linear motor. Linear motors only support
translational motor encoders and translational position encoders.

MEnc/PEnc

LinM

Fig. 16: Limited translational motion: Linear motor
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Encoder arrangement

You parameterize the encoder arrangement by using B26 Motor encoder and I02 Position encoder. The motor encoder for
velocity control is located on the motor shaft. The position encoder for position control is located on the gearbox output. If
you use only one of the two encoders, it will be used for both velocity and position control.

Encoder Parameterization Encoder arrangement

Motor encoder B26 ≠ 0: Inactive

I02 = 0: Motor encoder
MEnc

n
n

1

2

Gear unit PEnc

M

Position encoder B26 ≠ 0: Inactive

I02 = B26
MEnc

n
n

1

2

Gear unit PEnc

M

Motor encoder & position
encoder

B26 ≠ 0: Inactive

I02 ≠ B26
MEnc

n
n

1

2

Gear unit PEnc

M



STOBER 6 | More on Drive Based Synchronous?
10

/2
02

5 
| 

ID
 4

43
05

9.
04

101

6.4 Limit switches
With limit switches, you can secure the travel range by selecting the respective end of the travel range and thus limiting the
permitted positions of the axis. Hardware limit switches and software limit switches are available to limit the travel range.
Hardware and software limit switches can be used individually or in combination with each other.

Hardware limit switches are physical sensors (hardware) that are triggered when a certain position is reached, while
software limit switches are purely software-implemented functions for position limiting that are only available when the
travel range is limited (I00 = 0: Limited).

Function

When a limit switch is overshot, event 53: Limit switch is triggered and the axis goes into a fault condition with or without a
quick stop, depending on the parameterization. As soon as a limit switch is triggered, the motion core interrupts the current
motion command and refuses further commands in the same direction of motion. The direction lock ensures that the axis
can only move away from the limit switch in the opposite direction and return to the permitted travel range. As soon as the
direction lock is deactivated, event 53: Limit switch can be triggered again.

Further information on event 53: Limit switch, possible causes and actions can be found in the drive controller manual (see
Further information [} 148]).

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

▪ Allow sufficient space past the limit switch for your application to bring the axis to a standstill.

Restriction of the direction of motion

With an endless travel range, a direction lock can also be triggered by a positioning command outside the revolution length
or by restricting the direction of motion using I04 (travel range: I00 = 1: Endless; revolution length: I01; permitted direction:
I04). A restriction of the direction of motion is also indicated in the operating state of the axis (operating state: E80).

Since restricting the direction of motion using I04 prevents the hardware limit switch from moving in the opposite direction
of motion, it is generally not advisable to combine the two functions.
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6.4.1 Hardware limit switches
Hardware limit switches can be used for both limited and endless travel ranges (travel range: I00). A digital input or a
fieldbus can serve as the source for the digital signal for evaluating the respective hardware limit switch (source: I101, I102).

The digital signals for evaluating the hardware limit switches are low-active (normally closed contact), i.e. the limit switch is
triggered when the digital signal is interrupted (signal: I441, I442 = 0: Inactive). Ensure that the hardware limit switches and,
if necessary, the controller are connected correctly to prevent false triggering of event 53: Limit switch.

Relevant parameters

§ I101 Source positive /limit switch

§ I102 Source negative /limit switch

§ I441 Signal /HW limit switch positive

§ I442 Signal /HW limit switch negative

§ I805 Actual value HW-Limit switch positive

§ I806 Actual value HW-Limit switch negative

§ I52 Delete limit switch memory

§ I196 Direction blocking

Normal operation

When a hardware limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.

Causes

§ 1: Hardware-Limit-Switch positive (prerequisite: I441 = 0: Inactive)

§ 2: Hardware-Limit-Switch negative (prerequisite: I442 = 0: Inactive)

A hardware limit switch is triggered when the digital signal for evaluating the hardware limit switches is interrupted. The
motion core interrupts the current motion command and refuses further commands in the same direction of motion; a
direction lock becomes active (denial: I91 = 1: Active; cause: I90; direction lock: I196).

The direction lock is deactivated as soon as the limit switch memory is reset.

Jog mode

With hardware limit switches, the behavior of the axis is independent of the control type selected for jog mode (I26). When
a hardware limit switch is overshot, the axis behaves the same way in jog mode as in normal operation.

Referencing

During referencing, hardware limit switches can be evaluated like reference switches by using the corresponding
referencing type (referencing type: I30 = 2: Limit switch; referencing methods: A, C, E, G).

With other referencing types, a triggered hardware limit switch reverses the direction of motion if the limit switch matches
the direction of motion (e.g. positive limit switch and positive direction of motion). If a triggered hardware limit switch does
not match the direction of motion, fault 53: Limit switch is triggered (e.g. positive limit switch with negative direction of
motion).

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The referencing direction is
positive. The axis moves in the positive direction and first encounters the positive limit switch, not the reference switch.
The axis reverses and searches for the reference switch in the other direction.
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Limit switch memory

When a hardware limit switch is overshot, the position of the limit switch is saved internally and the triggered limit switch is
recorded as active in the limit switch memory as long as the axis is at or past the limit switch (limit switch memory: I805,
I806). Based on the stored position of the limit switch and the digital signals for evaluating the hardware limit switches, the
limit switch memory is automatically reset in normal operation as soon as the axis has returned to the permitted travel
range.

I442

I806

I805

I441

1

4

3

2

Permitted travel range

HW limit switch negative HW limit switch positive

Position of the axis

Fig. 17: Hardware limit switch: Limit switch memory

1 Negative HW limit switch triggered, limit switch memory set

2 Negative HW limit switch exited, limit switch memory reset

3 Positive HW limit switch triggered, limit switch memory set

4 Positive HW limit switch exited, limit switch memory reset

Example

A positive hardware limit switch ranges from position 100 to 120; when moving in the positive direction of motion, it is
triggered at position 100 (signal: I441 = 1: Active → 0: Inactive). On the return journey, the tolerance may cause the real
hardware limit switch to be left at position 101 (signal: I441 = 0: Inactive → 1: Active). However, in order for the effective
limit switch or limit switch memory to be reset, position 100 must be reached or undershot.

The position of the limit switch is not stored in non-volatile memory, i.e. if the axis is outside the limit switches after
switching on, it must first be moved back into the permitted travel range.

During commissioning or in case of defective hardware limit switch connections, problems can arise with the saved
positions. These can be deleted with parameter I52. However, deletion only takes place if the corresponding limit switch
signal is inactive. Stored positions can also be deleted by referencing, setting a reference can be deleted using I452 or by
restarting the drive controller.

Controller start-up

If a controller is used as the source for the digital signals for evaluating the hardware limit switches and this is still in device
start-up while the drive controller and fieldbus communication are already active, event 53: Limit switch is triggered (cause:
7: Both limit switches not connected) and the limit switch memory is set (I805, I806 = 1: Active).

If the power unit has not yet been enabled since the supply voltage was switched on, the limit switch memory is
automatically reset as soon as the controller correctly transmits the signals for evaluating the hardware limit switches.
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6.4.2 Software limit switches
Software limit switches are only available with a limited travel range (I00 = 0: Limited). To be able to check the actual
position of the axis using software limit switches, the axis must be referenced.

The position of the negative software limit switch must be a smaller value than the position of the positive software limit
switch. If the same value is defined for both software limit switches, the function is deactivated.

Relevant parameters

§ I50 Software stop positive: Highest permitted position

§ I51 Software stop negative: Lowest permissible position

§ I22 Target window

§ I80 Current position

§ I196 Direction blocking

Normal operation

When a software limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.

Causes

§ 3: SW-limit switch positive (prerequisite: I80 > I50 + I22)

§ 4: SW-limit switch negative (prerequisite: I80 < I51 – I22)

A software limit switch is triggered if the actual position of the axis is outside the permitted travel range, taking the position
window into account. The motion core interrupts the current motion command and refuses further commands in the same
direction of motion; a direction lock becomes active (denial: I91 = 1: Active; cause: I90; direction lock: I196).

The direction lock is deactivated as soon as the actual position of the axis is back within the permitted travel range, taking
the position window into account.

Jog mode

With software limit switches, the behavior of the axis depends on the control type selected for jog mode (I26).

If I26 = 0: Velocity control, a quick stop is triggered instead of a fault reaction when a software limit switch is overshot in jog
mode, so that the axis comes to a standstill outside the permitted travel range depending on the quick stop deceleration
(deceleration: I17). The direction lock ensures that the axis can only move away from the limit switch in the opposite
direction and return to the permitted travel range.

When I26 = 1: Position control and the set position is outside the permitted travel range, the axis is braked with jog
deceleration and tip jerk so that the axis still comes to a standstill within the permitted travel range shortly before the
software limit switch (deceleration: I45; jerk: I18).

Referencing

Software limit switches are not evaluated during referencing (motion command I401 = 6: MC_Home).
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6.4.3 Virtual master
The position of the virtual master can be limited via software limit switches if the master axis model is limited (prerequisite:
G30 = 0: Limited). To be able to check the actual position of the virtual master using software limit switches, the virtual
master does not need to be referenced.

The position of the negative software limit switch must be smaller than the position of the positive software limit switch of
the virtual master. If the same value is defined for both software limit switches of the virtual master, the function will be
deactivated.

Relevant parameters

§ G146 Virtual master software limit switch +

§ G147 Virtual master software limit switch -

§ G161 Virtual master error

§ G163 Virtual master error cause

§ G190 Actual position virtual master

Normal operation

If a software limit switch of the virtual master is overshot, event 51: Virtual master software limit switch with fault reaction
is triggered (prerequisite: U24 = 3: Fault).

Causes

§ 1: SW-limit switch positive (prerequisite: G190 > G146)

§ 2: SW-limit switch negative (prerequisite: G190 < G147)

A software limit switch of the virtual master is triggered if the actual position of the virtual master is outside the position
range defined as permitted. The motion core of the virtual master cancels the current motion command and refuses further
commands in the same direction of motion (denial: G161 = 1: Active; cause: G163).

The direction lock ensures that the virtual master can only move away from the limit switch in the opposite direction of
motion and return to the permitted travel range. As soon as the actual position of the virtual master is within the permitted
travel range again, the fault can be triggered again (G147 < G190 < G146).

Information

In order to trigger the quick stop of the virtual master when event 51: Virtual master software limit switch occurs, the level
of the associated protective function must be selected accordingly (U24 = 3: Fault) and the axis fault must be defined as an
additional quick-stop cause for the virtual master (G57 = 1: Error/3: Enable or error).

To trigger the quick stop of the virtual master when event 51: Virtual master software limit switch occurs, proceed as
described in Parameterizing the virtual master [} 34].
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6.5 Referencing
To be able to work with a system with absolute positions, the relation of a measured axis position to an actual axis position
must be determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is unknown. A defined initial
position is necessary. As a rule, this is either identified through a reference search or referencing setting. The associated
process is referred to as referencing.

Absolute movements can be performed only in a referenced state. For relative movements, referencing is only required if
the software limit switch function is used at the same time.

When replacing a drive controller, the reference can be transferred to the replacement drive controller via an SD card. The
information is also saved on the SD card if the action A00 Save values is executed for the referenced axis. For more
information on replacing a drive controller, refer to the manual for the respective drive controller.

6.5.1 Referencing methods
The following table shows an overview of the possible referencing methods.

Abbreviation Meaning

S Switch

M/F Torque or force

Method Initial
movement

Zero pulse Feature

S  A Negative Yes Negative limit switch

B Negative Yes Negatively positioned reference switch

C Negative – Negative limit switch

D Negative – Negatively positioned reference switch

S E Positive Yes Positive limit switch

F Positive Yes Positively positioned reference switch

G Positive – Positive limit switch

H Positive – Positively positioned reference switch

S I Positive Yes Centrally positioned reference switch

J Positive – Centrally positioned reference switch

S K Negative Yes Centrally positioned reference switch

L Negative – Centrally positioned reference switch

M Negative Yes Zero pulse

N Positive Yes Zero pulse

O – – Setting the reference

M/F P Positive – Torque/force stop

Q Positive Yes Torque/force stop

M/F R Negative – Torque/force stop

S Negative Yes Torque/force stop

Tab. 5: Referencing methods
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6.5.1.1 Referencing methods in detail

The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

Abbreviation Meaning

ALT Alternative

LS Limit Switch

RS Reference Switch

ZP Zero Pulse

Information

For graphically representing axes, the left is the smallest and the right is the largest position value. This means a positive
movement goes to the right and a negative to the left.

The following parameters are used in the descriptions of the referencing methods:

Coordinate Name

I28 Homing torque/force limit

I29 Time homing torque/force limit

I30 Referencing type

I31 Referencing direction

I32 Referencing speed fast

I33 Referencing speed slow

I34 Reference position

I35 Referencing with zero pulse

I39 Referencing acceleration

I43 Move to reference position

I44 Referencing jerk

I53 Index search offset

I101 Source positive /limit switch

I102 Source negative /limit switch

I103 Source reference switch
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6.5.1.1.1 Referencing method A

Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

LS+LS-

LS-

ZP

Preparation

1. Activate referencing method A by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 1: Active.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity I33 until it reaches
the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.2 Referencing method B

Referencing method B determines the reference using a run to the negatively positioned reference switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method B by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.3 Referencing method C

Referencing method C determines the reference using a run to the negative limit switch.

LS-

LS+LS-

Preparation

1. Activate referencing method C by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity I33 until it leaves
the limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.4 Referencing method D

Referencing method D determines the reference using a run to the negatively positioned reference switch.

RS

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method D by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.5 Referencing method E

Referencing method E determines the reference using a run to the positive limit switch and zero pulse.

LS+

ZP

LS+LS-

Preparation

1. Activate referencing method E by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 1: Active.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity I33 until it reaches
the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.6 Referencing method F

Referencing method F determines the reference using a run to the positively positioned reference switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method F by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.7 Referencing method G

Referencing method G determines the reference using a run to the positive limit switch.

LS+

LS+LS-

Preparation

1. Activate referencing method G by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity I33 until it leaves the
limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.8 Referencing method H

Referencing method H determines the reference using a run to the positively positioned reference switch.

RS

RS

ALT 2

ALT 1

Preparation

1. Activate referencing method H by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the negative direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.9 Referencing method I

Referencing method I determines the reference using a run to the centered reference switch and zero pulse.

LS+LS- RS

RS

ZP

ALT 2

ALT 1

ALT 3

LS+

Preparation

1. Activate referencing method I by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch until the reference switch is reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 after leaving the reference switch and upon
reaching the next zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.10 Referencing method J

Referencing method J determines the reference using a run to the centered reference switch.

LS+LS- RS

RS

ALT 2

ALT 1

ALT 3

LS+

Preparation

1. Activate referencing method J by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32 until it leaves the
reference switch.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. Upon reaching the positive limit switch, the drive changes its direction and continues its run until it reaches the
reference switch.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.11 Referencing method K

Referencing method K determines the reference using a run to the centered reference switch and zero pulse.

ALT 2

ALT 1

ALT 3

RS

ZP

ALT 2

ALT 1

ALT 3

LS-

LS+LS- RS

Preparation

1. Activate referencing method K by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 and continues its run until it reaches the next
zero pulse after leaving the reference switch.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.12 Referencing method L

Referencing method L determines the reference using a run to the centered reference switch.

RS

ALT 2

ALT 1

ALT 3

LS-

LS+LS- RS

Preparation

1. Activate referencing method L by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. When the reference switch is reached, the drive changes its velocity to I33 and continues its run until it leaves the
reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.13 Referencing method M

This method determines the reference using a run to the zero pulse.

ZP

Preparation

1. Activate referencing method M by setting the following parameters to the specified values:
I30 to 3: Zero pulse,
I31 to 1: Negative,

2. I32, I39, I44, I34:
Define the set values necessary for the referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.

6.5.1.1.14 Referencing method N

Referencing method N determines the reference using a run to the zero pulse.

ZP

Preparation

1. Activate referencing method N by setting the following parameters to the specified values:
I30 to 3: Zero pulse,
I31 to 0: Positive,

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.15 Referencing method O

Referencing method O determines the reference by setting the reference to any position.

Preparation

1. I30: 
Activate referencing method O by setting this parameter to 5: Define home.

2. I34: 
Define the reference position.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

The current actual position is set to the value of the reference position I34.

6.5.1.1.16 Referencing method P

Referencing method P determines the reference using a run with a torque/force stop.

Preparation

1. Activate referencing method P by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force limit is reached and
the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.17 Referencing method Q

Referencing method Q determines the reference using a run with a torque/force stop and zero pulse.

ZP

Preparation

1. Activate referencing method Q by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and when the time stored in I29 has passed, and
continues its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.18 Referencing method R

Referencing method R determines the reference using a run with a torque/force stop.

Preparation

1. Activate referencing method R by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force stop is reached and
the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.19 Referencing method S

Referencing method S determines the reference using a run with torque/force stop and zero pulse.

ZP

Preparation

1. Activate referencing method S by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and after the time stored in I29 has passed, and continues
its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

6.5.2 Reference position
Depending on the referencing type I30, the actual position I80 is replaced by the reference position I34 during the
referencing event.

6.5.3 Reference retaining
STOBER offers a convenient drive-based referencing system. Depending on the encoder model used and the reference
management, different types of reference retaining (I46) are offered.
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6.5.4 Reference loss

Axis

In certain cases, an axis loses its reference, and its state changes from I86 = 1: Active to I86 = 0: Inactive.

Normal operation (axis)

During normal operation, encoder faults or actions can lead to a loss of the reference. If the reference was deleted by an
encoder event, it can subsequently be restored.

Information

Before restoring the reference, check the actual position displayed (I80). If in doubt, do the referencing again. If relative
encoders are used or if the axis was still moving during the encoder fault, the actual position displayed may deviate from
the real actual position of the axis.

Cause Check and action

Event 76: Position encoder Encoder fault Actual position may still be correct, restoring
the reference is possible:

§ Check the actual position (I80).

§ Confirm reference (I130) or re-reference
axis

Event 37: Motor encoder Encoder fault When using the motor encoder as a position
encoder (I02 = 0: Motor encoder), 2 faults are
triggered (37: Motor encoder and 76: Position
encoder); in display parameter E82 and in the
fault memory it is possible that only one fault is
displayed.

Actual position may still be correct, restoring
the reference is possible:

§ Check the actual position (I80).

§ Confirm reference (I130) or re-reference
axis

Action I38 Deleted reference Action I38 deletes the reference but does not
change the actual position displayed.

Actual position may still be correct, restoring
the reference is not possible:

§ Check the actual position (I80).

§ Reference the axis again

Tab. 6: Loss of reference of the axis in normal operation
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Parameter changes (axis)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Cause Check and action

Changing parameters Changed axis model Actual position is undefined if one of the
following parameters was changed:

§ B26 Motor encoder

§ C15 Gear ratio n1

§ C16 Gear ratio n2

§ C17 Feed constant numerator

§ C18 Feed constant denominator

§ I00 Position range

§ I01 Circular length

§ I02 Position encoder

§ I03 Axis polarity

§ I05 Type of axis

§ I07 Distance factor numerator position

§ I08 Distance factor denominator position

It is not possible to restore the reference:

§ Reference the axis again

Changing parameters Changed encoder interface Actual position is undefined if a parameter of
the H group was changed.

It is not possible to restore the reference:

§ Reference the axis again

Tab. 7: Reference loss of the axis due to parameter changes

Restarting the drive controller (axis)

Depending on the encoder type and method for reference retaining (I46), the reference of a previously referenced axis is
restored or deleted after a restart.

By default (I46 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if the axis was
referenced with this encoder. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in I46. In addition to the preset, the following further options are
available:

§ Reference is retained if the measuring range covers the entire travel range

§ Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (I48)

§ Reference is retained regardless of the presence of an encoder

§ Reference is retained regardless of the encoder type

§ Reference is deleted when the drive controller is switched off
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Special case of incorrect motor connection (axis)

If a motor is inadvertently connected to the incorrect axis or the incorrect drive controller, such as after a case of service,
the drive controller behaves as follows after it is switched on:

§ The axis changes to the non-referenced state (I86 = 0: Inactive)

§ The actual position displayed is undefined

However, the information from the original motor and the associated reference data are stored in the drive controller.
After switching off the drive controller, connecting the correct motor and restarting the drive controller, the reference is
restored and the actual position is displayed correctly (prerequisites: multi-turn absolute encoder, referenced axis and
preset for reference retaining I46 = 0: Normal).

Master encoder

Actual positions of the master encoder are used in the Drive Based Synchronous application for synchronous operation.

In all applications except the Drive Based Center Winder application, the actual position of the master encoder can be used
to pass on the position of another encoder attached to the machine to the control system. The drive controller transfers the
position from the encoder interface to the respective fieldbus.

Master encoders behave in a similar way to position encoders. In certain cases, a master encoder loses its reference, and its
state changes from G89 = 1: Active to G89 = 0: Inactive.

Normal operation (master encoder)

During normal operation, encoder faults can lead to a loss of the reference.

Cause Check and action

Event 77: Master encoder Encoder fault Actual position of the master encoder is
undefined, it is not possible to restore the
reference:

§ Reference the master encoder again

Tab. 8: Reference loss of the master encoder in normal operation
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Parameter changes (master encoder)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Cause Check and action

Changing parameters Changed axis model Actual position of the master encoder is
undefined if one of the following parameters
was changed:

§ G30 Position range master

§ G40 Circular length master

§ G47 Distance factor numerator master

§ G48 Distance factor denominator master

§ G104 Source master encoder

It is not possible to restore the reference:

§ Reference the master encoder again

Changing parameters Changed encoder interface Actual position of the master encoder is
undefined if a parameter of the H group was
changed.

It is not possible to restore the reference:

§ Reference the master encoder again

Tab. 9: Reference loss of the master encoder due to parameter changes

Restarting the drive controller (master encoder)

Depending on the encoder type and method for reference retaining (G35), the reference of a previously referenced master
encoder is restored or deleted after a restart.

By default (G35 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if this encoder was
used for referencing. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in G35. In addition to the preset, the following further options are
available:

§ Reference is retained if the measuring range covers the entire travel range

§ Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (I48)

§ Reference is retained regardless of the presence of an encoder

§ Reference is retained regardless of the encoder type

§ Reference is deleted when the drive controller is switched off

Virtual master

By definition, the virtual master has no reference. Its actual position can be set directly to a value and used as a reference.
The reference is retained even after a restart.
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6.6 Drive Based device control
Drive Based device control is based on DRIVECOM profile drive technology 21; this profile describes the control sequence of
a drive controller based on a device state machine. Each device state here represents a certain behavior that can be
changed only through defined events. These events are assigned to individual state transitions.

Some of the conditions and responses coupled with the state transitions can be influenced specific to the user. For
example, it is possible to define the end of a quick stop or enable delays in a way that is tailored to the respective
application case (see wizard Drive Based device control).

The following chapters describe the device states and the possible state transitions associated with them. You will also
learn whether certain actions are necessary on your part to reach the individual device states, what those actions are and
which user-specific factors you can parameterize yourself.

6.6.1 Drive Based device state machine
The device state machine describes the different device states of the drive controller along with the possible state changes.

Not ready to switch on

Switch on disabled

Ready to switch on

Switched on

Operation enabled

Fault reaction active

Faults

Quick stop active

0

16

1

2 6

53

4

10
12
13

11

7

15

14

8

9

Fig. 18: Drive Based device state machine: device states and state changes

Priority levels are marked by dots. The more dots a state change has, the higher its priority. Accordingly, a state change
without any dots has the lowest priority.
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6.6.2 States, transitions and conditions
The states provided by Drive Based device control all have specific features. A state either transitions into another state
automatically or requires certain actions from the user. There are also transition conditions that you can parameterize to be
tailored to your application case using the Drive Based device control wizard.

Parameter E48 shows the current device state of a drive controller.

6.6.2.1 Key

The following terms are used in the descriptions of the states, transitions and conditions:

Term Meaning

Enable active Additional enable signal is active (A300 = 1: Active, source: A60)

Enable is inactive Additional enable signal is inactive (A300 = 0: Inactive, source: A60)

Quick stop in case of Enable-off active Quick stop in case of Enable-off is active (A44 = 1: Active)

Quick stop in case of Enable-off inactive Quick stop in case of Enable-off is inactive (A44 = 0: Inactive)

Quick stop end Standstill reached (I199 = 1: Active)
OR
maximum quick stop duration has expired (A39)
OR
A45 = 1: No stop and quick stop request ist inactive

Quick stop duration expired Maximum quick stop duration has expired (A39)

Autostart active Autostart is active (A34 = 1: Active)

Autostart inactive Autostart is inactive (A34 = 0: Inactive)

Tab. 10: States, transitions and conditions: Terms

6.6.2.2 Not ready to switch on

Features

§ Drive controller and safety module are initialized and tested

§ The power unit as well as drive and activation functions are locked

§ Brakes remain engaged

Transition to Switch on disabled (1)

The drive controller switches to the Switch on disabled state automatically after initialization and successfully completing
the self-test (typically approx. 30 s).

Transition to Fault reaction active (14), priority:    

Fault with or without fault reaction
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6.6.2.3 Switch on disabled

Features

§ Initialization has been completed

§ Self-test was successfully completed

§ The power unit as well as drive and activation functions are locked

§ Brakes remain engaged, release override can be requested with a rising edge

Possible causes of a switch-on lockout include:

1. Enable is active (A300) and Autostart is inactive (A34); cause only in the Switch on disabled state)

2. Insufficient or no supply voltage/DC link feed-in

3. STO safety function is active

4. Release override is active (source: F06; cause only in the Switch on disabled, Ready to switch on and Switched on
states)

5. Control panel or local operation is active (cause only in the Switch on disabled, Ready to switch on and Switched on
states)

For the exact cause of a switch-on lockout, refer to parameter E49.

Application-specific parameterization

A34 Auto start:

If this parameter is enabled, the drive controller switches directly to the Ready to switch on state in case of a pending
enable signal.

WARNING!

Injury to persons and material damage due to unexpected motor startup!

Only activate autostart if the standards and regulations applicable to the system or machine in question permit a direct
switch to the Ready to switch on device state.

▪ In accordance with EN 61800-5-1, clearly mark an activated autostart on the system and in the associated system
documentation.

Transition to Ready to switch on (2)

Enable inactive AND no cause for a switch-on lockout

OR

Enable active AND Autostart active AND no cause for a switch-on lockout

Transition to Fault reaction active (14), priority:    

Fault with or without fault reaction
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6.6.2.4 Ready to switch on

Features

§ Power unit and drive function are disabled

§ Drive controller is ready to switch on

§ Brakes remain engaged, release override can be requested with a rising edge

Application-specific parameterization

In addition to the enable signal at terminal X1, the Drive Based device state machine also supports the use of an additional
enable signal, for example over a fieldbus or using digital inputs. The enable signal and additional enable signals are coupled
by an AND link. In this case, the drive controller is enabled only if the value of both signals is HIGH.

A60 Source additional enable:

If you are working with an additional enable signal, define the data source of the additional signal in this parameter. In the
case of a fieldbus connection, A180 bit 0 supplies the additional enable signal.

Transition to Switched on (3)

Enable active

Transition to Switch on disabled (6), priority: 

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority:    

Fault with or without fault reaction

6.6.2.5 Switched on

Features

§ Power unit is ready for operation

§ Drive function is locked; set values are not processed

§ Brakes remain engaged, release override can be requested with a rising edge

Transition to Operation enabled (4)

Enable active

Transition to Ready to switch on (5), priority: 

Enable inactive

Transition to Switch on disabled (13), priority:  

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority:    

Fault with or without fault reaction
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6.6.2.6 Operation enabled

Features

§ Power unit is switched on

§ Drive function is enabled, set values are processed

§ Brakes are released with the first active motion command

Application-specific parameterization

§ A43 Switch-off delay X1 enable:
If the enable signal at terminal X1 of a safety relay is affected by OSSD test pulses, the drive controller cannot
differentiate these signals from a functional enable-off. An incorrect interpretation of the test pulses can be avoided by
defining a delay time in this parameter that is greater than the duration of the test pulses. This then eliminates
unexpected switching of the drive controller to the states Ready to switch on or Quick stop active (see parameter A44).

§ A44 Quick stop at enable off:
This parameter results in a drive being stopped with a quick stop in case of an inactive enable. In this case, the drive
controller switches to the Quick stop active state. If parameter A44 is not activated, the drive switches to the Ready to
switch on state in case of Enable-off. In this case, the drive is brought to an uncontrolled standstill, the power unit is
disabled and axis movement is no longer controlled by the drive controller.

§ A29 Quick stop in case of fault
This parameter results in a drive being stopped with a quick stop in case of a fault. In this case, the drive controller
switches to the Quick stop active state. If parameter A29 is not activated, the drive switches to the Fault reaction active
state in the event of a fault. In this case, the drive is brought to an uncontrolled standstill, the power unit is disabled
and axis movement is no longer controlled by the drive controller.

Transition to Quick stop active (7)

Request for a quick stop

OR

Enable inactive AND quick stop in case of Enable-off active

OR

Request for drive-controlled SS1

OR

Request for drive-controlled SS2

Transition to Ready to switch on (11), priority: 

Enable inactive AND quick stop in case of Enable-off inactive

Transition to Switch on disabled (12), priority:  

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority:    

Fault with or without fault reaction

6.6.2.7 Quick stop active

Features

§ Power unit is switched on; drive function is enabled
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§ A quick stop is executed

§ Brakes remain released, brake engages at the end of the quick stop or at standstill

§ Brake engaging ends the quick stop

Application-specific parameterization

§ A39 Maximum quick stop duration for enable off:
If the drive is stopped with a quick stop in the case of an inactive enable signal (see A44), define the maximum time
after which the power unit is switched off in this parameter.

§ A45 Quick stop end:
Define whether a quick stop is ended with a standstill of the drive or by canceling the quick stop request in this
parameter.

§ A62 Source /quick stop:
Define how a requested quick stop is triggered in this parameter.

Transition to Operation enabled (8)

No quick stop request

AND

Enable active

AND

Quick stop end

AND

No SS1

AND

No SS2

Transition to Ready to switch on (9), priority: 

Enable inactive AND quick stop in case of Enable-off inactive

OR

Enable inactive AND quick stop end

Transition to Switch on disabled (10), priority:  

Cause for a switch-on lockout

OR

No SS1 AND no SS2 AND quick stop end

OR

SS1 AND standstill

Transition to Fault reaction active (14), priority:    

Fault with or without fault reaction
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6.6.2.8 Fault reaction active

Features

§ A drive error has occurred

§ Fault reaction is executed depending on the respective fault event

§ Brakes are activated depending on the respective fault reaction

Application-specific parameterization

A29 Quick stop in case of fault:

If this parameter is activated, the drive is stopped with a quick stop, if possible, in case of fault; if the parameter is inactive,
the movement of the axis is no longer controlled by the drive controller.

Transition to Fault (15)

Fault reaction finished

6.6.2.9 Fault

Features

§ A drive error has occurred

§ The fault reaction is finished

§ The power unit as well as drive and activation functions are locked

§ Brakes engage

Transition to Switch on disabled (16)

After remedying the fault cause and then acknowledging the fault message, the drive controller automatically switches to
Switch on disabled.
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6.7 Motion commands
The operating modes of the application feature special motion commands that are based on the PLCopen standard and are
supplemented by two manufacturer-specific motion commands (MC_DoNothing and MC_MoveSpeed). Any motion
command – except MC_Stop – can be interrupted during execution. To be able to execute a motion command, the
following requirements must be met:

§ Local and jog mode must not be activated

§ A drive controller must not be in the Switch on disabled or Fault device state

Command Description Control type Necessary motion variables

0: MC_DoNothing — — —

8: MC_MoveSpeed Axis moves without end with
set velocity
(without position control)

Velocity § Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

4: MC_MoveVelocity Axis moves without end with
set velocity
(with position control)

Position § Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

9: MC_TorqueControl Axis moves without end with
set torque/force

Torque/force § Torque/force

2: MC_MoveRelative Axis moves a relative
distance;
set position is relative to the
actual position at the start of
the command

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

3: MC_MoveAdditive Axis moves a relative
distance;
set position is relative to the
set position of the previous
motion command

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

1: MC_MoveAbsolute Axis moves to an absolute
set position
(referencing necessary)

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

6: MC_Home Axis is referenced Depending on the selected
referencing type

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

§ Torque/force
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Command Description Control type Necessary motion variables

11: MC_Halt Axis is stopped;
next command can be run
before standstill

Velocity § Deceleration

§ Jerk

5: MC_Stop Axis is brought to a
standstill;
next command can be
executed after standstill

Velocity § Deceleration

§ Jerk

12: MC_GearIn Axis moves synchronously
with a master; velocity-
based coupling (electronic
gearbox)

Position § Acceleration

§ Deceleration

§ Jerk

14: MC_GearInPosition Axis moves synchronously
with a master; position-
based coupling (electronic
gearbox)

Position § Position, master position

13: MC_GearOut Axis ends the ongoing
synchronous motion and
continues with the last
synchronous velocity
(electronic gearbox)

Position § Velocity override

§ Acceleration

§ Deceleration

§ Jerk

Tab. 11: Drive Based Synchronous: Available motion commands

For detailed information on the motion commands, refer to the associated manual (see Further information [} 148]).
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6.8 Continue function
In Drive Based Synchronous type applications, the continue function allows you to resume interrupted motion commands,
for example after a quick stop, the triggering of safety technology or after an event with a fault reaction. Using the continue
function, you can also continue motion commands 2: MC_MoveRelative and 3: MC_MoveAdditive and end with the desired
set position, which would not be possible when restarting using the execute signal.

Cancellation causes that can be continued

§ Event with fault reaction

§ Enable-off

§ Motion command 5: MC_Stop, 11: MC_Halt

§ Stop signal

§ Quick stop signal

§ SS1, SS2

§ Jog

Motion commands

Motion command (I401) Continue Note

0: MC_DoNothing – –

1: MC_MoveAbsolute ✓ Motion continues until the set position is reached; set position is
absolute

2: MC_MoveRelative ✓ Motion continues until the set position is reached; set position is relative
to actual position at the start of the command

3: MC_MoveAdditive ✓ Motion continues until the set position is reached; set position is
relative to the set position of the previous motion command

4: MC_MoveVelocity ✓ Motion continues without end at set velocity

5: MC_Stop – –

6: MC_Home – –

8: MC_MoveSpeed ✓ Motion continues without end at set velocity

9: MC_TorqueControl ✓ Motion continues without end with set torque/force

11: MC_Halt – –

12: MC_GearIn – –

13: MC_GearOut – –

14: MC_GearInPosition – –
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Motion block operating mode

In motion block operating mode, the digital inputs, control byte of motion block operating mode or Motion block control
panel can serve as the source for the continue signal (control byte: J01; continue source: J917). The continue signal not only
continues the interrupted motion command, but also the entire motion block chain.

Cause of cancellation Continue Note

Event with fault reaction ✓ –

Enable-off ✓ –

Motion command 5: MC_Stop – Motion command 5: MC_Stop can be part of a motion block chain

Motion command 11: MC_Halt ✓ Motion command 11: MC_Halt can be part of a motion block chain;
continue is only possible with stop signal via control byte (prerequisite:
J06 = 2: Parameter J01)

Stop signal (I440 = 0: Inactive) – Stop signal is operated from the control panel in motion block operating
mode and is used to stop and end the motion block chain

Quick stop signal (A302 = 
0: Inactive)

✓ –

SS1 ✓ –

SS2 ✓ –

Jog (I443 = 1: Active) – –

Motion block reset

You can use the continue function to continue an interrupted motion block if both the motion command and the cause of
cancellation can be continued. If it is not possible to resume the motion block or you do not want to continue the
interrupted motion block, it always has to be deleted from the continue memory by means of a reset before a new motion
block can be started using the execute signal.
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6.9 Electronic nameplate
STOBER synchronous servo motors are generally equipped with EnDat encoders that provide a special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and electronic
values of a motor.

When you operate a drive controller with a STOBER synchronous servo motor and an EnDat encoder, the electronic
nameplate is read and all data transferred if the drive controller is connected online. This specifically includes job data,
current controller values, motor parameters, data on motor temperature sensors, brakes, the commutation offset and the
measured electromotive force. These can be manually optimized later and resaved in the drive controller.

Every time a drive controller is restarted, it checks whether the projected motor, the brake (if applicable), the motor
temperature sensor or commutation have been changed. If so, the changed data is read out. The optimizations saved in the
drive controller are maintained whenever possible.

The automatic read-out of the electronic nameplate is activated at the factory (B04 Electronic nameplate = 64: Active).

6.10 Lag monitoring
In Drive Based Synchronous type applications, you can monitor the lag of the axis with active position control in order to
detect increasing position deviations at an early stage. Monitoring the lag allows you to react quickly before material
damage can occur, e.g. in the event of stiffness or a mechanical blockage of the output.

To monitor the lag, the difference between the actual position of the axis and the set position x2set of the control is
determined and compared with the maximum permissible lag (actual position: I80; set position: I96; permissible lag: I21;
result: I187). If the permitted lag is exceeded, event 54: Following error is triggered with the corresponding protection level
(protection level: U22).
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7 Appendix

7.1 Standard mapping of Drive Based Synchronous

Information

For fieldbus communication via PROFINET, the processing of process data in some controllers is WORD-oriented (16 bits). In
Drive Based applications, the standard mapping is pre-assigned appropriately. If changes are made to the standard
mapping, take the parameter data type that you are adding to or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.
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7.1.1 SC6, SI6: Drive Based Synchronous receive process data
The following table shows the standard mapping for the receive process data in the Drive Based and Drive Based
Synchronous applications. For fieldbus communication via PROFINET, the process data mapping for axis A is done via
parameter A90 and for axis B via A91. For fieldbus communication via EtherCAT, the process data mapping for axis A is done
via parameter A225 and for axis B via A226. If necessary, the standard mapping can be customized.

Byte Data type Name Parameters

0 BYTE Device control byte 1.A180

1 BYTE Control byte command 1.J37

2 – 3 WORD Control word application 1.I210

4 INT8 Command 1.J40

5 INT8 Motion-ID 1.J41

6 – 9 INT32 Position 1.J42

10 – 13 REAL32 Velocity 1 1.J43

14 – 17 REAL32 Velocity Override 1.J56

18 – 21 REAL32 Torque/Force reference 1.G469

22 BYTE Control byte motion block 1.J01

23 – 24 INT16 Reference motion block 1.J02

Tab. 12: SC6, SI6: receive process data (standard mapping); first part, axis A

Byte Data type Name Parameters

0 BYTE Device control byte 2.A180

1 BYTE Control byte command 2.J37

2 – 3 WORD Control word application 2.I210

4 INT8 Command 2.J40

5 INT8 Motion-ID 2.J41

6 – 9 INT32 Position 2.J42

10– 13 REAL32 Velocity 1 2.J43

14 – 17 REAL32 Velocity Override 2.J56

18 – 21 REAL32 Torque/Force reference 2.G469

22 BYTE Control byte motion block 2.J01

23 – 24 INT16 Reference motion block 2.J02

Tab. 13: SC6, SI6: receive process data (standard mapping); second part, axis B
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7.1.2 SC6, SI6: Drive Based Synchronous transmit process data
The following table shows the standard mapping for the transmit process data in the Drive Based and Drive Based
Synchronous applications. For fieldbus communication via PROFINET, the process data mapping for axis A is done via
parameter A94 and for axis B via A95. For fieldbus communication via EtherCAT, the process data mapping for axis A is done
via parameter A233 and for axis B via A234. If necessary, the standard mapping can be customized.

Byte Data type Name Parameters

0 BYTE Status byte device 1.E200[0]

1 BYTE Status byte device 1.E200[1]

2 – 3 WORD Status word 2 1.E201

4 BYTE Status byte application 1.I212

5 BYTE Status byte command 1.J39

6 – 7 WORD Status word application 1.I200

8 – 11 INT32 Current position 1.I80

12 – 15 REAL32 Actual speed 1.I88

16 – 19 REAL32 Actual torque/force 1.E90

20 – 21 WORD Status word user-defined 1.A67

22 INT8 Operating condition 1.E80

23 BYTE Status byte motion block 1.J302

24 – 25 INT16 Actual motion block 1.J300

26 INT8 Device control state 1.E48

Tab. 14: SC6, SI6: transmit process data (standard mapping); first part, axis A

Byte Data type Name Parameters

0 BYTE Status byte device 2.E200[0]

1 BYTE Status byte device 2.E200[1]

2 – 3 WORD Status word 2 2.E201

4 BYTE Status byte application 2.I212

5 BYTE Status byte command 2.J39

6 – 7 WORD Status word application 2.I200

8 – 11 INT32 Current position 2.I80

12 – 15 REAL32 Actual speed 2.I88

16 – 19 REAL32 Actual torque/force 2.E90

20 – 21 WORD Status word user-defined 2.A67

22 INT8 Operating condition 2.E80

23 BYTE Status byte motion block 2.J302

24 – 25 INT16 Actual motion block 2.J300

26 INT8 Device control state 2.E48

Tab. 15: SC6, SI6: transmit process data (standard mapping); second part, axis B
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7.2 Further information
The documentation listed below provides you with further relevant information on the 6th STOBER drive controller
generation. The current status of the documentation can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter the ID of the documentation in the search field.

Title Documentation Contents ID

SC6 drive controller Manual System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

442790

Multi-axis drive system with SI6
and PS6

Manual System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

442728

PROFINET communication – SC6,
SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

443039

EtherCAT communication – SC6,
SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

443025

SR6 safety technology – STO via
terminals

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442741

SU6 safety technology – STO and
SS1 via PROFIsafe

Manual Technical data, installation, commissioning,
diagnostics, detailed information

443258

SY6 safety technology – STO and
SS1 via FSoE

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442744

SX6 safety technology – Safe drive
monitoring using FSoE

Manual Technical data, installation, commissioning,
diagnostics

443337

Motion commands Manual Control and status information, denials and
limitations, motion

443349

http://www.stoeber.de/en/downloads/
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7.3 Abbreviations

Abbreviation Meaning

AI Analog Input

ALT Alternative

CAN Controller Area Network

CB Controller Based

CiA CAN in Automation

CNC Computerized Numerical Control

DI Digital Input

EtherCAT Ethernet for Control Automation Technology

IDT Internal Data Transfer mechanism

IGB Integrated Bus

LinM Linear Motor

LS Limit Switch

LSB Least Significant Bit

M Motor

M/F Torque or force

MEnc Motor Encoder

PEnc Position Encoder

PROFINET Process Field Network

RS Reference Switch

S Switch

PLC Programmable Logic Controller

VM Virtual Master

ZP Zero Pulse
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8 Contact

8.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

If you need our system support:
Phone: +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone: +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone: +49 7231 582-3000

Our address is:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12
75177 Pforzheim, Germany

8.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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8.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
+43 7613 7600-0
sales@stoeber.at

STOBER CHINA 
www.stoeber.cn 
+86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE 
www.stober.fr 
+33 478 98 91 80 
sales@stober.fr

STOBER Germany 
www.stoeber.de 
+49 7231 582-0
sales@stoeber.de

STOBER ITALY 
www.stober.it 
+39 02 93909570 
sales@stober.it

STOBER JAPAN 
www.stober.co.jp 
+81-3-5875-7583
sales@stober.co.jp

STOBER KOREA 
www.stober.kr 
+82 10 5681 6298 
sales@stober.kr

STOBER SWEDEN 
www.stober.com 
+46 702 394 675
neil.arstad@stoeber.de

STOBER SWITZERLAND 
www.stoeber.ch 
+41 56 496 96 50 
sales@stoeber.ch

STOBER TAIWAN 
www.stober.tw 
+886 4 2358 6089 
sales@stober.tw

STOBER TURKEY 
www.stober.com 
+90 216 510 2290 
sales-turkey@stober.com

STOBER UK 
www.stober.co.uk 
+44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
+1 606 759 5090 
sales@stober.com
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Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Control cascade

Complete model of the control structure with the position controller, velocity controller and current controller
components.

Electronic nameplate

The synchronous servo motors are generally equipped with absolute encoders that provide special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and
electronic values of a motor. When you operate a drive controller with a synchronous servo motor and an absolute
encoder, the electronic nameplate is read and all motor data transferred if the drive controller is connected online. The
drive controller automatically determines the associated limit values and control parameters from this data.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

PID controller

Universal controller type with a P-, I- and D-share. These three adjustment parameters make the controller flexible and
ensure exact and highly dynamic control. However, by implication, it also necessitates a wide variety of variants. It is
that much more important to ensure careful construction that is well-coordinated to the system. The application areas
for this controller type are control circuits with systems of the second order and higher, which must be stabilized
quickly and do not allow for any permanent control deviation.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.
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